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Safety information

AN

Always follow basic safety precautions
when using this product to reduce risk
of injury from fire or electric shock.

1. Read and understand all
instructions in the documentation that
comes with the printer.

2. Observe all warnings and
instructions marked on the product.

3. Unplug this product from wall
outlets before cleaning.

4. Do not install or use this product
near water, or when you are wet.

5. Install the product securely on

a stable surface.

6. Install the product in a protected
location where no one can step on or
trip over the line cord, and the line
cord cannot be damaged.

7. If the product does not operate
normally, see Solve a problem.

8. There are no user-serviceable parts
inside. Refer servicing to qualified
service personnel.
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1 Get started

This guide provides details about how to use the printer and how to resolve problems.

. Accessibility

. HP EcoSolutions (HP and the Environment)
. Understand the printer parts

. Use the printer control panel

. Select paper

. Load paper
. Insert a memory device

. Install the accessories

. Maintain the printer

. Update the printer

. Open the printer software (Windows)
. Turn the printer off

. Restore factory defaults

Br NOTE: If you are using the printer with a computer running Windows XP Starter
Edition, Windows Vista Starter Edition, Windows 7 Starter Edition, or Windows 8
Starter Edition, some features might not be available. For more information, see
System requirements.

Accessibility

The printer provides a number of features that make it accessible for people with
disabilities.

Visual

The HP software provided with the printer is accessible for users with visual
impairments or low vision by using your operating system's accessibility options and
features. The software also supports most assistive technology such as screen
readers, Braille readers, and voice-to-text applications. For users who are color blind,
colored buttons and tabs used in the HP software and on the printer control panel have
simple text or icon labels that convey the appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed
through keyboard commands. The HP software also supports Windows accessibility
options such as StickyKeys, ToggleKeys, FilterKeys, and MouseKeys. The printer
doors, buttons, paper trays, and paper guides can be operated by users with limited
strength and reach.

Support

For more details about the accessibility of this printer and HP's commitment to product
accessibility, visit HP's website at www.hp.com/accessibility.

For accessibility information for Mac OS X, visit the Apple website at www.apple.com/
accessibility.

Get started 7
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HP EcoSolutions (HP and the Environment)

HP is committed to helping you optimize your environmental footprint and empowering
you to print responsibly—at home or in the office.

For more detailed information about environmental guidelines HP follows during the
manufacturing process, see Environmental product stewardship program. For more
information about HP's environmental initiatives, visit www.hp.com/ecosolutions.

Manage power
To conserve electricity, try the following:

. Turn on the printer's Sleep Mode feature, and then select the option for the
shortest time. After the printer has been inactive for this period of time, the printer
will go into low-power mode. To configure this feature, touch €4 (eco button)
on the printer’s control panel display, touch Sleep, and then touch the desired
option.

. Use the printer's Schedule On and Off feature, and then select the days and time
you want the printer to turn on and turn off automatically. For example, you can
schedule the printer to turn on at 8am and turn off at 8pm from Monday to Friday.
In this way, you will save energy during the night and weekends. To configure this
feature, touch 2L (eco button) on the printer's control panel display, touch
Schedule On and Off, and then set the time to turn on and off the printer.

. Adjust the screen brightness to a dimmer setting. To configure this feature, touch

0 (eco button) on the printer's control panel display, touch Screen
Brightness, and then set the desired option.

Bf NOTE: The printer's Sleep Mode and Schedule On and Off features are
temporarily not available if one or more of the ink cartridges are missing. After the
cartridge is reinstalled, these features resume.

/\ CAUTION: HP recommends that you replace any missing cartridges as soon as
possible to avoid print quality issues and possible extra ink usage or damage to the
ink system. Never turn off the printer when ink cartridges are missing.

Optimize printing supplies

To optimize printing supplies such as ink and paper, try the following:

. Recycle used original HP ink cartridges through HP Planet Partners. For more
information, visit www.hp.com/recycle.

. Optimize paper usage by printing on both sides of the paper. If the printer has an
HP automatic two-sided printing accessory (duplexer), see Print on both sides
(duplexing).

. Save ink and paper when printing web content with HP Smart Print. For more
information, visit www.hp.com/go/smartprint.

. Change the print mode to a draft setting. The draft setting uses less ink.

. Do not clean the printhead unnecessarily. This wastes ink and shortens the life of
the cartridges.
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Understand the printer parts

This section contains the following topics:
. Front view

. Printing supplies area

. Back view

Front view
1 Ink cartridge access door
2 Front universal serial bus (USB) port
3 Output tray
4 Tray 1
5 Output tray extension
6 [_|J (Power button)
7 Control panel

Understand the printer parts
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Printing supplies area

1 Ink cartridge access door
2 Ink cartridges

3 Printhead

4 Printhead latch

Back view

1 Ethernet network port

Rear universal serial bus (USB) port

Power input

AW DN

Automatic two-sided printing accessory (duplexer)
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Use the printer control panel

This section contains the following topics:
. Overview of buttons and lights

. Control panel display icons

. Change printer settings

Overview of buttons and lights

The following diagrams and related tables provide a quick reference to the printer
control panel features for each printer model.

f

(G

-m\\\

(A ?
<4 4
= X

J

Label

Name and Description

Wireless icon: The light next to the icon is lit when the 802.11 wireless feature is on, and the
printer is connected to a network. If the light is blinking the wireless feature is on, but the
printer is not connected to a network. If the light is off, the wireless feature is turned off.

Home button: Returns to the home screen from any other screen.

w

Control panel display: Touch the screen to select menu options. For information about the
icons that appear on the display, see Control panel display icons.

Help button: Opens the Help menu.

Cancel button: Stops a job, exits a menu, or exits settings.

Right arrow button: Navigates through settings in the menus.

Left arrow button: Navigates through settings in the menus.

0N | oS

Back button: Returns to the previous menu.

Use the printer control panel 11
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Control panel display icons

Icon

Purpose

Shows that an Ethernet network connection exists.

Shows that a wireless network connection exists, and provides access to the
wireless status and settings. The signal strength is indicated by the number of
curved lines. This is for infrastructure mode. For more information, see Set up the
printer for wireless communication.

Shows that HP ePrint is turned on. For more information, see HP ePrint.

Displays a screen where you can use HP Apps. For more information, see Printer
Apps.

Displays a screen where you can adjust photo printing options.

Displays the Setup screen for generating reports, changing maintenance settings,
and accessing the Help screen.

12
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(continued)

Icon Purpose

Displays the Network screen for selecting options.

Provides more information about the printer's features.

Displays a screen where you can see information about the ink cartridges,
including fill levels. This icon has a red border when an ink cartridge needs
attention.

NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having
a replacement cartridge available to avoid possible printing delays. You do not
need to replace cartridges until prompted to do so.

Displays a screen where you can learn about printer features that can help
conserve natural resources and reduce the impact of your printing choices.

TIP: You can configure settings for some features from this screen.

Change printer settings

Use the control panel to change the printer's mode and settings, print reports, or get
help for the printer.

X): TIP: If the printer is connected to a computer, you can also change the printer
" settings using HP software tools available on your computer, such as the HP printer
software, HP Utility (Mac OS X), or the EWS. For more information about these
tools, see Printer management tools.

This section contains the following topics:

. Select the mode
. Change printer settings

Select the mode
The main menu of the control panel display shows the available modes for the printer.

Br NOTE: To select a mode, touch the 4 (left arrow) or the e (right arrow) to see the
available modes, and then touch the icon to select the desired mode. Follow the
prompts on the control panel display to complete the job. The control panel display
returns to the main menu when the job is finished.

Use the printer control panel 13
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To select a different mode

Touch #5 (Back button) to return to the main menu. Touch + (left arrow) or e (right
arrow) to scroll through the available modes, and then touch the icon to select the
desired mode.

To change settings for a mode

1.  After selecting a mode, touch the arrow buttons to scroll through the available
settings, and then touch the setting you want to change.

2.  Follow the prompts on the display to change the settings, and then touch Done.

Bf NOTE: Touch *5 (Back button) to return to the previous menu.

Change printer settings

To change the printer settings or print reports, use the options available in the Setup
menu:

1.  Touch e (right arrow), and then touch Setup.

2.  Touch the arrow buttons to scroll through the menus.

3.  Touch the menu items to select menus or options.

Bf NOTE: Touch *5 (Back button) to return to the previous menu.

Select paper

The printer is designed to work well with most types of office media. It is best to test
a variety of print media types before buying large quantities. Use HP media for
optimum print quality. For more information about HP media, visit the HP website at

www.hp.com.

HP recommends plain papers with the ColorLok logo for printing
of everyday documents. All papers with the ColorLok logo are
independently tested to meet high standards of reliability and
print quality, and produce documents with crisp, vivid color,
bolder blacks and dry faster than ordinary plain papers. Look for
papers with the ColorLok logo in a variety of weights and sizes
from major paper manufacturers.

This section contains the following topics:

. Recommended papers for printing

. Recommended papers for photo printing
. Tips for selecting and using paper

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.
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Depending on your country/region, some of these papers might not be available.

HP Brochure Paper
HP Professional Paper

These papers are glossy-coated or matte-coated on both sides for
two-sided use. They are the perfect choice for producing professional
quality marketing materials such as brochures and mailers, as well as
business graphics for report covers and calendars.

HP Premium
Presentation Paper

HP Professional Paper

These papers are heavy two-sided matte papers perfect for
presentation, proposals, reports, and newsletters. They are
heavyweight for an impressive look and feel.

HP Bright White Inkjet
Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp
text. It is opaque enough for two-sided color usage with no
showthrough, which makes it ideal for newsletters, reports, and flyers.
It features ColorLok Technology for less smearing, bolder blacks, and
vivid colors.

HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces
documents that look and feel more substantial than documents
printed on standard multipurpose or copy paper. It features ColorLok
Technology for less smearing, bolder blacks, and vivid colors.

HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for
copies, drafts, memos and other everyday documents. It features
ColorLok Technology for less smearing, bolder blacks, and vivid
colors.

HP Office Recycled
Paper

HP Office Recycled Paper is a high-quality multifunction paper made
with 30% recycled fiber. It features ColorLok Technology for less
smearing, bolder blacks and vivid colors.

To order HP papers and other supplies, go to www.hp.com. Go to Shop for Products
and Services, and select Ink, toner and paper .

Br NOTE: At this time, some portions of the HP website are available in English only.

Recommended papers for photo printing

For the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. Depending on your country/region,
some of these papers might not be available.

Depending on your country/region, some of these papers might not be available.

HP Premium Plus
Photo Paper

HP’s best photo paper is heavyweight for producing professional
quality photos. Features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm
(4 x6inch), 13 x 18 cm (5 x 7 inch), and two finishes — glossy or soft-
gloss (satin matte). It is acid-free for longer lasting documents.

HP Advanced Photo
Paper

This thick photo paper features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
Your prints have a look and feel comparable to a store processed
photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10
x 15 cm (4 x 6 inch), 13x18 cm (5 x 7 inch), and two finishes — glossy
or soft gloss (satin matte). It is acid-free for longer lasting documents.
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(continued)

HP Everyday Photo Print colorful, everyday snapshots at a low cost, using paper
Paper designed for casual photo printing. This affordable, photo paper dries

quickly for easy handling. Get sharp, crisp images when you use this
paper with any inkjet printer. Available in semi-gloss finish in 8.5 x 11
inch, A4, 4 x 6 inch, and 10 x 15 cm. It is acid-free for longer lasting
documents.

To order HP papers and other supplies, go to www.hp.com. Go to Shop for Products
and Services and select Ink, toner and paper.

Bf NOTE: At this time, some portions of the HP website are available in English only.

Tips for selecting and using paper

For the best results, observe the following guidelines.

Always use media that conforms to the printer specifications. For more
information, see Paper specifications.

Load only one type of media at a time into a tray or automatic document feeder
(ADF).

When loading the trays, make sure the media is loaded correctly. For more
information, see Load paper.

Do not overload the tray. For more information, see Load paper.

Load paper

This section provides instructions for loading media into the printer, and contains the
following topics:

Load standard-size paper
Load envelopes

Load cards and photo paper
Load custom-size paper

Load standard-size paper

Use these instructions to load standard paper.

1.

Pull out Tray 1.
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2. Insert the media print-side down in the center of the tray. Make sure the stack of
media aligns with the line on the width guide, and is not higher than the paper
stack line on the guide.

Bf NOTE: Do notload paper while the printer is printing.

3.  Slide the paper guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

Bf NOTE: To load legal-size paper, press the blue latch at the bottom left of the
input tray and fully extend the tray.

4. Pull out the extension on the output tray.

Load envelopes
Use these instructions to load an envelope.
1. Pullout Tray 1.

Load paper 17
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2. Insert the envelopes print-side down and load according to the graphic. Make
sure the stack of envelopes does not exceed the line marking in the tray.
B NOTE: Do not load paper while the printer is printing.
3.

Slide the paper guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

4. Pull out the extension on the output tray.

Load cards and photo paper

Use these instructions to load cards or photo paper.
1. Pullout Tray 1.
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2. Insert the media print-side down in the center of the tray. Make sure the stack of
media aligns with the line on the width guide, and is not higher than the paper
stack line on the guide.

Bf NOTE: Do notload paper while the printer is printing.

3.  Slide the paper guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

4. Pull out the extension on the output tray.

Load custom-size paper
Use these instructions to load custom-size paper.

/A CAUTION: Use only custom-size paper that is supported by the printer. For more
information, see Paper specifications.

Br NOTE: Load only plain paper in Tray 2.

1. Pullout Tray 1.

2. Insert the media print-side down in the center of the tray. Make sure the stack of
media aligns with the line on the width guide, and is not higher than the paper
stack line on the guide.

Bf NOTE: Do not load paper while the printer is printing.
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3.  Slide the paper guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

4. Pull out the extension on the output tray.

Insert a memory device

If your digital camera uses a memory card to store photos, you can connect the
camera to the printer to print your photos.

/A CAUTION: Attempting to remove a memory card while it is being accessed can
damage files on the card. You can safely remove a card only when the photo light
is not blinking. Also, never insert more than one memory card at a time as this can
also damage files on the memory cards.

Bf NOTE: The printer does not support encrypted memory cards.
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For more information on the supported memory cards, see Memory device
specifications.
To connect a storage device

1. If you are connecting a digital camera, change the USB mode of the camera to
storage mode, and then connect one end of the USB cable to the camera.

Br NOTE: Different cameras use different terms to describe the storage mode.
For instance, some cameras have a digital camera setting and a disk drive
setting. In this instance, the disk drive setting is the storage mode setting. If
storage mode does not work on your camera, you might need to upgrade the
camera firmware. For more information, see the documentation that came
with the camera.

2. Insert the USB storage device or the other end of the camera’s USB cable to the
USB port on the front of the printer.

Br NOTE: If your USB device does not fit into this port due to size limitations, or if the
connector on the device is shorter than 11 mm (0.43 in), you will need to purchase
a USB extension cable in order to use your device with this port. For more
information on supported USB devices, see Memory card specifications.

Install the accessories

This section contains the following topics:
. Install the automatic two-sided printing accessory (duplexer)

. Install Tray 2

. Configure trays
. Turn on accessories in the printer driver

Install the automatic two-sided printing accessory (duplexer)

You can print on both sides of a sheet of paper automatically. For information on using
the duplexer, see Print on both sides (duplexing).

To install the duplexer:

Slide the duplexer into the back of the printer until the unit locks into place. Do not
press the buttons on either side of the duplexer when installing the unit; use them only
for removing the unit from the printer.
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Install Tray 2

Tray 2 can hold up to 250 sheets of plain paper. For ordering information, see HP
supplies and accessories.

To install Tray 2

1. Unpack the tray, remove the packing tapes and materials, and move the tray to
the prepared location. The surface must be sturdy and level.

2.  Turn off the printer, and disconnect the power cord.
3.  Set the printer on top of the tray.

/A CAUTION: Be careful to keep your fingers and hands clear of the bottom of
the printer.

4. Connect the power cord and turn on the printer.

To load Tray 2
1. Pull the tray out of the printer by grasping under the front of the tray.

2. Insert the paper print-side down in the center of the tray. Make sure the stack of
paper aligns with the line on the width guide, and does not exceed the line
marking on the guide.

Br NOTE: Tray 2 can be loaded only with plain paper.

3.  Slide the paper guides in the tray to adjust them for the size that you have
loaded.
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4. Gently reinsert the tray.

5.  Pull out the extension on the output tray.

.

Configure trays

Br NOTE: Tray 2 is an optional accessory. For ordering information, see Order

printing supplies online.

To configure the trays, you must have Tray 2 installed and turned on.

By default, the printer draws media from Tray 1. If Tray 1 is empty, the printer draws
media from Tray 2 (if it is installed and loaded with media). You can change this default

behavior by using the following features:

. Tray Lock: Use this feature to protect special media such as letterhead or
preprinted media from accidental use. If the printer runs out of media while
printing a document, it will not use media from a locked tray to complete the print

job.

. Default Tray: Use this feature to determine the first tray from which the printer

draws media.

Br NOTE: To use the tray lock and default tray settings, you must select the
automatic tray selection option in the printer software. Also, if the printer is on a
network and you set a default tray, the setting will affect all users of the printer.

Tray 2 is designed to hold only plain paper.

The following table lists possible ways you can use the tray settings to meet your

printing needs.

| want to...

Follow these steps

Load both trays with the same media, and
have the printer pick media from one tray if the
other one is empty.

Load media in Tray 1 and Tray 2. For
more information, see Load paper.

Make sure tray lock is disabled.

Have both special media (such as letterhead)
and plain paper loaded in the trays.

Load special media in Tray 1 and plain
paper in Tray 2.

Make sure the default tray is set to Tray
2.

Make sure tray lock is set to Tray 1.
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(continued)

| want to... Follow these steps

Load media in both trays but have the printer . Load media in Tray 1 and Tray 2.

pick media from a specific tray first.

. Make sure default tray is set to the
appropriate tray.

To configure the trays

1.
2.

3.

Make sure the printer is turned on.

Touch e (right arrow), touch Setup, touch Preferences, and then select Default
Tray or Tray Lock.

Click OK or Apply after changing the desired tray settings.

Turn on accessories in the printer driver

To turn on accessories (Windows)
To turn on accessories (Mac OS X)

To turn on accessories (Windows)

1.

Click Start, and then click Printers or Printers and Faxes or Devices and
Printers.

-Or-

Click Start, click Control Panel, and then double-click Printers.
Right-click the printer icon, and then click Printer Properties.

Select the Device Settings tab. Click the accessory that you want to turn on,
click Installed from the drop-down menu, and then click OK.

To turn on accessories (Mac OS X)

Mac OS X automatically turns on all accessories in the printer driver when you install
the printer software. If you add a new accessory later, follow these steps:

1.

2.
3.
4

Open the System Preferences and then select Print & Fax or Print & Scan.
Select the printer from list of printers, and then click Options & Supplies.
Click the Driver tab.

Select the options you want to install, and then click OK.

Maintain the printer

This section provides instructions for keeping the printer in top working condition.
Perform these maintenance procedures as necessary.

Clean the exterior

Clean the exterior

/A WARNING! Before cleaning the printer, turn the printer off by pressing the

LI_J (Power button) and unplug the power cord from the electrical socket.
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Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case.
Keep fluids away from the interior of the printer, as well as from the printer control
panel.

Update the printer

HP is always working to improve the performance of its printers and bring you the
latest features. If the printer is connected to a network and Web Services has been
enabled, you can check for and install printer updates.

To update the printer, use one of the following methods:

Update the printer using the embedded web server

Update the printer using the printer control panel

Update the printer using the embedded web server
Open the EWS. For more information, see Embedded web server.
Click the Web Services tab.

In the Web Services Settings section, click Product Update, click Check Now,
and follow the on-screen instructions.

If the product update option is not available, follow these instructions:

1.
2,
3.

a.

b.

In the Web Services Settings section, click Setup, click Continue, and
follow the on-screen instructions.

If prompted, choose to allow the printer to check for and install printer
updates.

Bf NOTE: If a printer update is available, the printer downloads and installs the

update, and then restarts.

NOTE: If prompted for proxy settings and if your network uses proxy
settings, follow the on-screen instructions to set up a proxy server. If you do
not have the details, contact your network administrator or the person who set
up the network.

Update the printer using the printer control panel

1.

2,

On the printer control panel, touch ] (HP ePrint), touch Settings, and then

touch Printer Update.

Touch Check for Update Now, and then follow the on-screen instructions.

To enable the printer to automatically check for updates:

1.
2,

Touch Settings, and then touch Printer Update.
Touch Auto Update, and then touch On.
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Open the printer software (Windows)

. Windows XP, Windows Vista, and Windows 7: From the computer desktop,
click Start, select Programs or All Programs, click HP, click the folder for your
printer, and then select the icon with your printer's name.

. Windows 8: On the Start screen, do one of the following.

° Right-click the Start screen, click All Apps on the App bar, and then click
the icon with your printer's name.

° Click Desktop, and then click the icon with your printer's name.
° Click the icon with your printer's name.

Turn the printer off

Turn the printer off by pressing the ILI_J (Power button) located on the printer. Wait until
the power light turns off before unplugging the power cord or turning off a power strip.

/A CAUTION: If you incorrectly turn the printer off, the print carriage might not return
to the correct position causing problems with the ink cartridges and print quality
issues.

CAUTION: HP recommends that you replace any missing cartridges as soon as
possible to avoid print quality issues and possible extra ink usage or damage to the
ink system. Never turn off the printer when ink cartridges are missing.

Restore factory defaults

To restore the the printer to factory defaults, complete the following steps:

1. Touch = (right arrow), and then touch Setup.
2. Touch Tools.
3. Touch Restore Factory Defaults.
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2 Print

Most print settings are automatically handled by the software application. Change the
settings manually only when you want to change print quality, print on specific types of
paper, or use special features. For more information about selecting the best print
media for your documents, see Select paper.

Choose a print job to continue:

Print documents

Print brochures

Print on envelopes
A

E Print photos

EI Print on special and custom-size paper

Print documents

Follow the instructions for your operating system.

. Print documents (Windows)
. Print documents (Mac OS X)

Br NOTE: This printer includes HP ePrint, a free service from HP that allows you to
print documents on your HP ePrint-enabled printer anytime, from any location, and
without any additional software or printer drivers. For more information, see HP
ePrint.

Print documents (Windows)
1. Load paper in the tray. For more information, see Load paper.
2.  On the File menu in your software application, click Print.
3.  Make sure the printer you want to use is selected.
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To change settings, click the button that opens the Printer Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

To change settings, click the button that opens the Printer Properties dialog box.
Change the paper orientation on the Finishing tab, and paper source, paper
type, paper size, and quality settings on the Paper/Quality tab. To print in black
and white, click the Color tab, and then select the Print in Grayscale option.
Click OK.

Click Print or OK to begin printing.

Print documents (Mac OS X)

1.
2,

Load paper in the tray. For more information, see Load paper.

Depending on your application use one of the following procedures to select a
paper size:

From Page Setup
a. From the File menu in your software application, click Page Setup.

BY NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
-OR-

From Print

a. From the File menu in your software application, click Print.

b. Make sure the printer you want to use is selected.

c. Select the paper size from the Paper Size pop-up menu (if available).

On the Print dialog change the print settings for the option provided in the pop-up
menus, as appropriate for your project.

Br NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

Click Print to begin printing.

Print brochures

Follow the instructions for your operating system, including edge-to-edge brochures.
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Print brochures (Windows)
Print brochures (Mac OS X)

Bf NOTE: This printer includes HP ePrint, a free service from HP that allows you to

Print

print documents on your HP ePrint-enabled printer anytime, from any location, and
without any additional software or printer drivers. For more information, see HP
ePrint.




Print brochures (Windows)

Br NOTE: To set print settings for all print jobs, make the changes in the HP software

hobh-=

provided with the printer. For more information on the HP software, see Printer
management tools.

Load paper in the tray. For more information, see Load paper.

On the File menu in your software application, click Print.

Make sure the printer you want to use is selected.

To change settings, click the button that opens the Printer Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Change the paper orientation on the Finishing tab, and paper source, paper

type, paper size, and quality settings on the Paper/Quality tab.

A To printin black and white, click the Color tab, and then select the Print in
Grayscale option.

A To print an edge-to-edge brochure, select one of the edge-to-edge paper
sizes, and then select the supported brochure paper from the Paper Type
drop-down box.

Click OK.

Click Print or OK to begin printing.

Print brochures (Mac OS X)

1.
2,

Load paper in the tray. For more information, see Load paper.

Depending on your application use one of the following procedures to select a
paper size:

From Page Setup
a. From the File menu in your software application, click Page Setup.

Br NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c.  Select the paper size from the Paper Size pop-up menu, and then click OK.
-OR-

From Print

a. From the File menu in your software application, click Print.

b. Make sure the printer you want to use is selected.

c.  Select the paper size from the Paper Size pop-up menu (if available).
From the File menu in your software application, click Print.
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4.  On the Print dialog click Color/Quality Option from the pop-up menu, and then
select the following settings:

. Media Type: The appropriate brochure paper type
. Print Quality: Draft, Normal, or Best

Br NOTE: If you do not see these options, click the disclosure triangle next to
the Printer pop-up menu or click Show Details.

5.  Select any other print settings that you want, and then click Print to begin
printing.

Print on envelopes

Avoid envelopes with the following characteristics:

. Very slick finish

. Self-stick adhesives, clasps, or windows

. Thick, irregular, or curled edges

. Areas that are wrinkled, torn, or otherwise damaged

Make sure the folds of envelopes you load in the printer are sharply creased.

Bf NOTE: For more information about printing on envelopes, see the documentation
available with the software program you are using.

Follow the instructions for your operating system.

. Print on envelopes (Windows)
. Print on envelopes (Mac OS X)

Print on envelopes (Windows)

1. Load envelopes print-side down in the tray. For more information, see Load
paper.

2.  On the File menu in your software application, click Print.

Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Printer Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5.  On the Layout tab, change the orientation to Landscape.

6. Click Paper/Quality, and then select the appropriate envelope type from the
Paper Size drop-down list.

w

Q TIP: You can change more options for the print job by using the features
available on the other tabs in the dialog box.

7.  Click OK, and then click Print or OK to begin printing.
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Print on envelopes (Mac OS X)

1.
2,

Load envelopes in the tray. For more information, see Load paper.

Depending on your application use one of the following procedures to select a
paper size:

From Page Setup
a. From the File menu in your software application, click Page Setup.

B NOTE: If you do not see a Page Setup menu item, go to step 3.

b.  Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
-OR-

From Print
a. From the File menu in your software application, click Print.
b.  Make sure the printer you want to use is selected.

c.  Select the appropriate envelope size in the Paper Size pop-up menu (if
available).

On the Print dialog select the Orientation option.

Bf NOTE: If you do not see these options, click the disclosure triangle next to
the Printer pop-up menu or click Show Details.

Select any other print settings that you want, and then click Print to begin
printing.

Print photos

Do not leave unused photo paper in the input tray. The paper might start to curl, which
could impair the quality of your printout. Photo paper should be flat before printing.

Follow the instructions for your operating system.

Print photos on photo paper (Windows)
Print photos on photo paper (Mac OS X)
Print photos from a memory device

Br NOTE: This printer includes HP ePrint, a free service from HP that allows you to

print documents on your HP ePrint-enabled printer anytime, from any location, and
without any additional software or printer drivers. For more information, see HP
ePrint.

Print photos on photo paper (Windows)

1.
2,
3.

Load paper in the tray. For more information, see Load paper.
On the File menu in your software application, click Print.
Make sure the printer you want to use is selected.
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To change settings, click the button that opens the Printer Properties dialog box.
Depending on your software application, this option might be called Properties,
Options, Printer Setup, Printer, or Preferences.

On the Paper/Quality tab, select the appropriate photo paper type from the
Paper type drop-down menu.

On the Paper/Quality tab, select Best from the Print Quality drop-down menu.
To print in black and white, click the Color tab, and then select the Print in
Grayscale option.

Click OK, and then click Print or OK to begin printing.

Print photos on photo paper (Mac OS X)
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1.
2,

Print

Load paper in the tray. For more information, see Load paper.

Depending on your application use one of the following procedures to select a
paper size:

From Page Setup
a. From the File menu in your software application, click Page Setup.

BY NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
-OR-

From Print

a. From the File menu in your software application, click Print.

b. Make sure the printer you want to use is selected.

c. Select the paper size from the Paper Size pop-up menu (if available).

On the Print dialog click Color/Quality Option from the pop-up menu, and then
select the following settings:

. Media Type: The appropriate photo paper type
. Print Quality: Draft, Normal, or Best

Br NOTE: If you do not see these options, click the disclosure triangle next to
the Printer pop-up menu or click Show Details.

To print the photo in black and white, click Grayscale from the Print Color as

Gray pop-up menu, and then select one of the following options:

. Off: Turns printing in grayscale off.

. Black Ink Only: Uses black ink to print your photo in grayscale. The gray
shading is created by varying patterns of black dots, which might result in a
grainy image.

. High Ink Only: Uses all the available colors to print your photo in grayscale.
This creates smooth and natural shades of gray.

Select any other print settings that you want, and then click Print to begin

printing.



Print photos from a memory device

You can connect a USB storage device (such as a keychain drive) to the USB port on
the front of the printer.

For more information about using memory devices, see Insert a memory device.

/A CAUTION: Attempting to remove a memory device while it is being accessed can
damage files on the memory device. You can safely remove a memory card only
when the status light is not blinking.

To print selected photos

Br NOTE: This function is only available if the memory device does not contain
Digital Print Order Format (DPOF) content.

1. Connect your memory device to the USB port on the front of the printer. The
Select Option screen appears on the control panel display.

2. Touch Photo. The Photo Menu screen appears.
Touch View & Print. The photos are displayed.

4. Follow the instructions on the control panel display to select, edit, or print the
photos.

i

Print on special and custom-size paper

If your application supports custom-size paper, set the size in the application before
printing the document. If not, set the size in the printer driver. You might need to
reformat existing documents to print them correctly on custom-size paper.

Use only custom-size paper that is supported by the printer. For more information, see
Paper specifications.

Br NOTE: Defining custom-size paper sizes is only available in the HP printing
software in Mac OS X.

Follow the instructions for your operating system.

. Print on special or custom-size paper (Windows)
. Print on special or custom-size paper (Mac OS X)
. Set up custom sizes (Mac OS X)

Print on special or custom-size paper (Windows)
1. Load the appropriate paper in the tray. For more information, see Load paper.
2 On the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4 To change settings, click the button that opens the Printer Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. On the Paper/Quality tab, click the Custom... button.
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Name the custom size and define the size of the paper on the Custom Paper
Size screen.

B NOTE: The custom paper size you have just defined will only be available
when you close and reopen the Printing Preferences or Printer Properties
dialog box.

Click the Paper/Quality tab, and select the custom paper size from the Paper
sizes: drop-down box.

Click OK.
Click Print or OK to begin printing.

Print on special or custom-size paper (Mac OS X)
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Bf NOTE: Before you can print on custom-size paper, you must set up the custom

Print

size in the HP software provided with the printer. For instructions, see Set up
custom sizes (Mac OS X).

Load the appropriate paper in the tray. For more information, see Load paper.

Depending on your application use one of the following procedures to select a
paper size:

From Page Setup
a. From the File menu in your software application, click Page Setup.

Bf NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
-OR-

From Print

a. From the File menu in your software application, click Print.

b. Make sure the printer you want to use is selected.

c. Select the paper size from the Paper Size pop-up menu (if available).

Click Paper Handling from the pop-up menu.

Above Destination Paper Size, click Scale to fit paper size, and then select the
custom size.

Select any other print settings that you want, and then click Print to begin
printing.



Set up custom sizes (Mac OS X)

1.  Load paper in the tray. For more information, see Load paper.

2.  From the File menu in your software application, click Page Setup, and then
make sure the printer you want to use is selected in the Format For pop-up
menu.

-OR -
From the File menu in your software application, click Print, and then make sure
the printer you want to use is selected.

3. Select Manage Custom Sizes in the Paper Size pop-up menu.

Bf NOTE: If you do not see these options in the Print dialog, click the
disclosure triangle next to the Printer pop-up menu or click Show Details.

4. Click the + on the left side of the screen, double-click Untitled, and type a name
for the new, custom size.

5. In the Width and Height boxes, type the dimensions, and then set the margins, if
you want to customize them.

6. Click OK.

HP ePrint

With HP ePrint, you can print from email connected mobile phones, netbooks, other
mobile devices, or traditional desktop email clients—anywhere, anytime. Using your
mobile device service and the printer's Web Services, you can print documents to

a printer that could be sitting next to you or sitting thousands of miles away.

To use the HP ePrint service, you need to have the following components:

. An HP ePrint-enabled printer that is connected to the Internet (either using an
Ethernet cable or wireless connection)
. A device that has a functioning email capability

Follow the instructions on the printer’s control panel to enable and set up the printer’s
Web Services. For more information, see www.hpconnected.com.

HP Wireless Direct

With HP wireless direct printing, you can print wirelessly from a computer, smart
phone, tablet, or other wireless-capable device—without connecting to an existing
wireless network.

When using HP wireless direct printing, note the following guidelines:

. Make sure your computer or mobile device has the necessary software:

If you are using a computer, make sure you have installed the HP printer software
provided with the printer.

. If you are using a mobile device, make sure you have installed a compatible
printing app. For more information about mobile printing, visit www.hp.com/global/
us/en/eprint/mobile_printing_apps.html.

. Make sure HP wireless direct printing is turned on in the printer and, if necessary,
security is enabled. For more information, see Turn on HP wireless direct printing.
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Up to five computers and mobile devices can use the same HP wireless direct
printing connection.

HP wireless direct printing can be used while the printer is also connected to a
computer using USB cable or to a network (using a wireless or Ethernet
connection).

HP wireless direct printing cannot be used to connect a computer, mobile device,
or printer to the Internet.

@ Click here to go online for more information.

For more information about wireless printing, see Set up the printer for wireless
communication.

Bf NOTE: At this time, these websites might not be available in all languages.

This section contains the following topics:

Turn on HP wireless direct printing
Print from a wireless-capable mobile device
Print from a wireless-capable computer

Turn on HP wireless direct printing

1.
2,

From the printer control panel, touch ¥ (Wireless), and then touch Settings.
Touch Wireless Direct, and then touch On.

Q- TIP: If you would like to use HP wireless direct printing with greater security
" and if the computer or mobile device supports WPA2 encryption, select the
option that will enable security. With security enabled, only users with the
password can connect wirelessly to the printer. Without enabling security,
anyone with a wireless device within the wireless range of the printer can

connect to the printer.

Touch Wireless Direct Name to display the wireless direct name.

If you have enabled security, touch Security Passcode to display the wireless
direct password.

Q TIP: You can also turn on HP wireless direct printing from the embedded web

server (EWS). For more information about using the EWS, see Embedded web
server.

Print from a wireless-capable mobile device

Make sure you have installed a compatible printing app on your mobile device. For
more information, visit www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

1.

2.
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Make sure you have turned on HP wireless direct printing on the printer. For more
information, see Turn on HP wireless direct printing.
Turn on the wireless connection in your mobile device. For more information, see
the documentation provided with the mobile device.
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From the mobile device, search for and connect to the HP wireless direct printing
name, such as HP-Setup-XX-Officejet Pro 251dw (where ** are the unique
characters to identify your printer).

If HP wireless direct is turned on with security, enter the password when
prompted.

From your mobile device’s print app, confirm your HP printer is the default printer,
and then print your document.

Print from a wireless-capable computer

Follow the instructions for your operating system.

Print from a wireless-capable computer (Windows)
Print from a wireless-capable computer (Mac OS X)

Print from a wireless-capable computer (Windows)

1.

Make sure you have turned on HP wireless direct printing on the printer. For more

information, see Turn on HP wireless direct printing.

Turn on the wireless connection in your computer. For more information, see the

documentation provided with the computer.

From the computer, click the wireless icon on your task tray, select the HP

wireless direct printing name, such as HP-Setup-XX-Officejet Pro 251dw (where

** are the unique characters to identify your printer).

If HP wireless direct is turned on with security, enter the password when

prompted.

If the printer has been installed and connected to your computer with a USB

cable, enable HP wireless direct printing in the HP printer software. Proceed to

step 5 if the printer has been installed and connected to the computer over a

network (Ethernet or wireless).

a. From the computer desktop, click Start, select Programs or All Programs,
click HP, click the folder for the printer, and then select Printer Setup &
Software.

-Or-

On the Start screen, right-click an empty area on the screen, click All Apps
on the app bar, and then click the icon with the printer's name.

Select Connect New Printer.

c. When the Connection Options software screen appears, select Wireless.
Select the printer from the list of detected printers, such as HP-Setup-XX-
Officejet Pro 251dw (where ** are the unique characters to identify your
printer).

d. Follow the on-screen instructions.

Print your document.

Print from a wireless-capable computer (Mac OS X)

1.

2,

Make sure you have turned on HP wireless direct printing on the printer. For more
information, see Turn on HP wireless direct printing.

Turn on AirPort. For more information, see the documentation provided by Apple.
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Click the AirPort icon and select the HP wireless direct printing name, such as
HP-Setup-XX-Officejet Pro 251dw (where ** are the unique characters to
identify your printer).
If HP wireless direct is turned on with security, enter the password when
prompted.
Add the printer.
a. In System Preferences, select Print & Fax or Print & Scan, depending on
your operating system.
Click + below the list of printers at the left.
Select the printer from the list of detected printers (the word “Bonjour” is
listed the right column beside the printer name), and click Add.
Print your document.

Print on both sides (duplexing)

You can print on both sides of a sheet of media automatically by using the automatic
two-sided printing accessory (duplexer).

38

Bf NOTE: Two-sided printing requires an automatic two-sided printing accessory

(duplexer) to be installed on the printer.

To print on both sides (Windows)

1.

2.

Load the appropriate media. For more information, see Guidelines for printing on
both sides of a page and Load paper.

Make sure the duplexer is installed correctly. For more information, see Install the
automatic two-sided printing accessory (duplexer).

With a document open, click Print on the File menu, and then select Print on
both sides options on the Finishing tab. Select Flip pages up if desired.

Change any other settings, and then click OK.
Print your document.

To print on both sides (Mac OS X)

1.

2,

Print

Load the appropriate media. For more information, see Guidelines for printing on
both sides of a page and Load paper.

Make sure the duplexer is installed correctly. For more information, see Install the
automatic two-sided printing accessory (duplexer).

Depending on your application use one of the following procedures to select a
paper size:

From Page Setup
a. From the File menu in your software application, click Page Setup.

BY NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.



-OR-

From Print
a. From the File menu in your software application, click Print.
b. Make sure the printer you want to use is selected.

4. On the Print dialog select the paper size from the Paper Size pop-up menu (if
available).

Bf NOTE: You might need to select the paper-size option labeled Two-Sided
margins.

5. Check the Two-Sided checkbox, and then click the appropriate binding options
for the document.
-OR-
Click the Layout pop-up menu, and then select the appropriate binding options
for the document from the Two-Sided pop-up menu.

Bf NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

6.  Select any other print settings that you want, and then click Print.

View Print Resolutions

1. In printer driver, click the Paper/Quality tab, and then click the Advanced button.
2.  Click the Resolution button to view the print resolution.
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3 Web Services

The printer offers innovative, web-enabled solutions that can help you quickly access
the Internet, obtain documents, and print them faster—and all without using a
computer.

’Lﬁvf NOTE: To use these web features, the printer must be connected to the Internet
(either using an Ethernet cable or wireless connection). You cannot use these web
features if the printer is connected using a USB cable.

This section contains the following topics:
. What are Web Services?

. Set up Web Services

. Use Web Services

. Remove Web Services

What are Web Services?

The printer includes the following Web Services:
. HP ePrint
. Printer Apps

HP ePrint

HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled
printer anytime, from any location. It's as simple as sending an email to the email
address assigned to your printer when you enable Web Services on the printer. No
special drivers or software are needed. If you can send an email, you can print from
anywhere, using HP ePrint.

Once you have signed up for an account on HP Connected, you can:

. Sign in to view your HP ePrint job status

. Manage your HP ePrint printer queue

. Control who can use your printer's HP ePrint email address to print
. Get help for HP ePrint

Printer Apps

Printer Apps allow you to easily locate and print preformatted web content, directly
from your printer.

Printer Apps provide a wide range of content, from store coupons to family activities,
news, travel, sports, cooking, photos, and many more. You can even view and print
your online images from popular photo sites.

Certain Printer Apps also allow you to schedule the delivery of app content to your
printer.
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Preformatted content designed specifically for your printer means no cut-off text and
pictures, and no extra pages with only one line of text. On some printers, you can also
choose paper and print quality settings on the print preview screen.

Set up Web Services

To set up Web Services, complete the following steps.

Br NOTE: Before you set up Web Services, make sure you are connected to the

Internet.

Set up Web Services using the HP printer software
Set up Web Services using the printer’s control panel
Set up Web Services using the embedded web server

Set up Web Services using the HP printer software

In addition to enabling key printer features, you can use the HP printer software that
came with your printer to set up Web Services. If you didn’t set up Web Services when
you installed the HP software on your computer, you can still use the software to set up
Web Services.

To set up Web Services, complete the following steps for your operating system:

Set up Web Services (Windows)

1.

7.

From the computer desktop, click Start, select Programs or All Programs, click
HP, click the folder for your printer, and then select the icon with your printer’s
name.

Double-click on the Printer Home Page under the Print section in the Print tab.
The printer's embedded web server opens.

On the Web Services tab, click Setup in the Web Services Settings section.
Click Accept Terms of Use and Enable Web Services, and then click Next.

Click Yes to allow the printer to automatically check for and install product
updates.

If your network uses proxy settings when connecting to the Internet, enter these
settings.

Follow the instructions on the Web Services information sheet to finish the setup.

Set up Web Services (Mac OS X)

A

To set up and manage Web Services in Mac OS X, you can use the printer’s
embedded web server (EWS). For more information, see Set up Web Services
using the embedded web server.

Set up Web Services using the printer’s control panel

The printer’s control panel provides an easy way to set up and manage Web Services.

To set up Web Services, complete the following steps:

1.
2,

Make sure the printer is connected to the Internet.

On the printer control panel, touch ' (Apps) or (HP ePrint).
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Touch Accept to accept the Web Services terms of use and enable Web
Services.

In the Auto Update screen, touch Yes to allow the printer to automatically check
for and install product updates.

If your network uses proxy settings when connecting to the Internet, enter these
settings:

a. Touch Enter Proxy.
b. Enter the proxy server settings, and then touch Done.
Follow the instructions on the Web Services information sheet to finish the setup.

Set up Web Services using the embedded web server

You can use the printer's embedded web server (EWS) to set up and manage Web
Services.

To set up Web Services, complete the following steps:

1.
2.
3.

Open the EWS. For more information, see Embedded web server.
On the Web Services tab, click Setup in the Web Services Settings section.

Click the Continue button, select Accept Terms of Use and Enable Web
Services, Enable Web Services, and Update Apps checkboxes, and then click
Next.

Click Yes to allow the printer to automatically check for and install product
updates.

If your network uses proxy settings when connecting to the Internet, enter these
settings.

Follow the instructions on the Web Services information sheet to finish the setup.

Use Web Services

The following section describes how to use and configure Web Services.

HP ePrint

HP ePrint allows you to print to your HP ePrint-enabled printer anytime, from any
location.

42

HP ePrint
Printer Apps

To use HP ePrint, make sure to have the following:

An Internet- and email-capable computer or mobile device
An HP ePrint-capable printer on which Web Services has been enabled

Q TIP: For more information about managing and configuring HP ePrint settings and

to learn about the latest features, visit HP Connected (www.hpconnected.com).

Web Services
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Print using HP ePrint
To print documents using HP ePrint, complete the following steps:

1. On your computer or mobile device, open your email application.

Bf NOTE: For information about using the email application on your computer
or mobile device, see the documentation provided with the application.

2. Create a new email message, and then attach the file that you want to print. For a
list of files that can be printed using HP ePrint, as well as guidelines to follow
when using HP ePrint, see HP ePrint.

3.  Enter the printer's email address in the “To” line of the email message, and then
select the option to send the email message.

BY NOTE: Make sure that the printer's email address is the only address listed
in the “To” line of the email message. If other email addresses are listed in the
“To” line, the attachments you are sending might not print.

Find the printer's email address

Br NOTE: Make sure you have created an ePrint account. To sign up for an account
on HP Connected, visit HP Connected at www.hpconnected.com.

From the Home screen, touch ] (HP ePrint).

Q TIP: To print the email address, touch Print Info.

Turn off HP ePrint
To turn off HP ePrint, complete the following steps:

1. 3
From the Home screen, touch J (HP ePrint), and then touch Settings.

2. Touch ePrint, and then touch Off.

Br NOTE: To remove all Web Services, see Remove Web Services.

Printer Apps

Printer Apps allow you to easily locate and print pre-formatted web content, directly
from your printer.

Use Printer Apps

To use the Printer Apps on your printer, touch Apps on the printer’s control panel
display, and then touch the Print App you want to use.

For more information about individual Printer Apps, visit (www.hpconnected.com).
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Manage Printer Apps

You can manage your Printer Apps with HP Connected. You can add, configure, or
remove Printer Apps, and set the order in which they appear on your printer’s display.

Bf NOTE: To manage Printer Apps from HP Connected, create an account on HP
Connected and add your printer. For more information, see
(www.hpconnected.com).

Turn off Printer Apps
To turn off Printer Apps, complete the following steps:

1- o
From the Home screen, touch ] (HP ePrint), and then touch Settings.

2. Touch Apps, and then touch Off.

EBf NOTE: To remove all Web Services, see Remove Web Services.

Remove Web Services

To remove Web Services, complete the following steps:

1. =
On the printer’s control panel display, touch (HP ePrint), and then touch
Settings.

2. Touch Remove Web Services.
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Work with ink cartridges

To ensure the best print quality from the printer, you need to perform some simple
maintenance procedures. This section provides guidelines for handling the ink
cartridges, instructions for replacing the ink cartridges, and aligning and cleaning the
printhead.

This section contains the following topics:

Information on ink cartridges and the printhead
Check the estimated ink levels

Printing with black or color ink only

Replace the ink cartridges

Store printing supplies

Anonymous Usage Information Storage

Information on ink cartridges and the printhead

The following tips help maintain HP ink cartridges and ensure consistent print quality.

The instructions in this user guide are for replacing ink cartridges, and are not
intended for first time installation.

/A CAUTION: HP recommends that you replace any missing cartridges as soon
as possible to avoid print quality issues and possible extra ink usage or
damage to the ink system. Never turn off the printer when ink cartridges are
missing.

Keep all ink cartridges in the original sealed packages until they are needed.

Be sure to turn off the printer properly. For more information, see Turn the printer
off.

Store ink cartridges at room temperature (15-35° C or 59-95° F).

Do not clean the printhead unnecessarily. This wastes ink and shortens the life of
the cartridges.

Handle ink cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems.

If you are transporting the printer, do the following to prevent ink leaking from the
printer or other damage from occurring to the printer:

o

Make sure you turn off the printer by pressing the LI_J (Power button). Wait
until all sounds of internal motion stop before unplugging the printer. For
more information, see Turn the printer off.

° Make sure you leave the ink cartridges and printhead installed.

° The printer must be transported sitting flat; it should not be placed on its
side, back, front, or top.

Related topics

Check the estimated ink levels
Printhead maintenance
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Check the estimated ink levels

You can check the estimated ink levels from the printer software or from the printer
control panel. For information about using these tools, see Printer management tools
and Use the printer control panel. You can also print the Printer Status page to view
this information (see Understand the Printer Status Report).

Bf NOTE: Ink level alerts and indicators provide estimates for planning purposes
only. When you receive a low-ink alert, consider having a replacement cartridge
available to avoid possible printing delays. You do not have to replace the
cartridges until you are prompted to do so.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge
that has been used in another printer, the ink level indicator might be inaccurate or
unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of
different ways, including in the initialization process, which prepares the printer and
cartridges for printing, and in printhead servicing, which keeps print nozzles clear
and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it
is used. For more information, see www.hp.com/go/inkusage.

Printing with black or color ink only

For regular usage, this product is not designed to print using only the black cartridge
when the color cartridges are out of ink.

However, your printer is designed to let you print as long as possible when your
cartridges start to run out of ink.

When there is sufficient ink in the printhead, the printer will offer you the use of black
ink only when one or more of the color cartridges are out of ink, and the use of color ink
only when the black cartridge is out of ink.

. The amount that you can print using black or color ink only is limited, so have
replacement ink cartridges available when you are printing with black or color ink
only.

. When there is no longer sufficient ink to print, you will get a message that one or
more cartridges are depleted, and you will need to replace the depleted
cartridges before you resume printing.

/A CAUTION: While ink cartridges are not damaged when left outside of the printer,
the printhead does need to have all cartridges installed at all times after the printer
is set up and in use. Leaving one or more cartridge slots empty for an extended
period may lead to print quality problems and possibly damage the printhead. If you
have recently left a cartridge out of the printer for an extended period, or if you have
had a recent paper jam, and have noticed poor print quality, clean the printhead.
For more information, see Clean the printhead.
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Replace the ink cartridges

Br NOTE: For information on recycling used ink supplies, see HP_inkjet supplies
recycling program

If you do not already have replacement ink cartridges for the printer, see Ink cartridges
and printheads.

Br NOTE: At this time, some portions of the HP website are available in English only.

NOTE: Not all cartridges are available in all countries/regions.

/\ CAUTION: HP recommends that you replace any missing cartridges as soon as
possible to avoid print quality issues and possible extra ink usage or damage to the
ink system. Never turn off the printer when ink cartridges are missing.

Use these steps to replace the ink cartridges.

To replace the ink cartridges
1.  Make sure the printer is turned on.
2.  Open the ink cartridge access door.

Bf NOTE: Wait until the print carriage stops moving before proceeding.

3. Press the front of the ink cartridge to release it, and then remove it from the slot.

4. Remove the new ink cartridge from its packaging.

5.  Using the color-coded letters for help, slide the ink cartridge into the empty slot
until it is securely installed in the slot.

/A CAUTION: Do not lift the latch handle on the print carriage to install the ink
cartridges. Doing so could cause the printhead or ink cartridges to be
incorrectly seated, which can cause errors or print quality problems. The latch
must remain down in order to correctly install the ink cartridges.
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Make sure that you insert the ink cartridge into the slot that has the same colored
letter as the color you are installing.

6. Repeat steps 3 through 5 for each ink cartridge you are replacing.
7.  Close the ink cartridge access door.

Related topics
Ink cartridges and printheads

Store printing supplies

Ink cartridges can be left in the printer for extended periods of time. However, to assure
optimal ink cartridge health, be sure to turn off the printer properly. For more
information, see Turn the printer off.

Anonymous Usage Information Storage

The HP cartridges used with this printer contain a memory chip that assists in the
operation of the printer.

In addition, this memory chip stores a limited set of anonymous information about the
usage of the printer, which might include the following: the date when the cartridge was
first installed, the date when the cartridge was last used, the number of pages printed
using the cartridge, the page coverage, frequency of printing, the printing modes used,
any printing errors that might have occurred, and the printer model.
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This information helps HP design future printers to meet our customers' printing needs.
The data collected from the cartridge memory chip does not contain information that
can be used to identify a customer or user of the cartridge or their printer.

HP collects a sampling of the memory chips from cartridges returned to HP's free
return and recycling program (HP Planet Partners: www.hp.com/hpinfo/
globalcitizenship/environment/recycle). The memory chips from this sampling are read
and studied in order to improve future HP printers. HP partners who assist in recycling
this cartridge might have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous
information on the memory chip. If you prefer to not allow access to this information,
you can render the chip inoperable. However, after you render the memory chip
inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can make this
information inaccessible by turning off the memory chip's ability to collect the printer's
usage information:

To disable the usage information function

1. On the printer control panel, touch e (right arrow), and then touch Setup.
2. Select Preferences, and then select Cartridge Chip Information.

3.  Touch OK to turn off usage information collection.

Br NOTE: To re-enable the usage information function, restore the factory defaults.

NOTE: You can continue to use the cartridge in the HP printer if you turn off the
memory chip's ability to collect the printer's usage information.
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Solve a problem

The information in this section suggests solutions to common problems. If your printer
is not operating correctly and these suggestions did not solve your problem, try using
one of the following support services to obtain assistance.

This section contains the following topics:

HP support
General troubleshooting tips and resources

Solve printer problems

Print quality troubleshooting

Solve paper-feed problems

Solve problems using Web Services and HP websites
Solve memory device problems

Solve Ethernet network problems

Solve wireless problems

Configure your firewall software to work with the printer
Solve printer management problems

Troubleshoot installation issues

Solve network problems

Understand the Printer Status Report

Printhead maintenance

Understand the network configuration page

Clear jams

HP support
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If you have a problem, follow these steps

1.
2,

Check the documentation that came with the printer.

Visit the HP online support website at www.hp.com/support. This website
provides information and utilities that can help you correct many common printer
problems. HP online support is available to all HP customers. It is the fastest
source for up-to-date printer information and expert assistance and includes the
following features:

. Fast access to qualified online support specialists
. HP software and driver updates for the HP printer
. Valuable troubleshooting information for common problems

. Proactive printer updates, support alerts, and HP newsgrams that are
available when you register the printer

For more information, see Obtain electronic support.

Call HP support. Support options and availability vary by printer, country/region,
and language. For more information, see HP support by phone.

Solve a problem
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Obtain electronic support

To find support and warranty information, go to the HP website at www.hp.com/
support. This website provides information and utilities that can help you correct many
common printer problems. If prompted, select your country/region, and then click
Contact HP for information about calling for technical support.

This website also offers technical support, drivers, supplies, ordering information and
other options such as:

. Access online support pages.

. Send HP an email message for answers to your questions.

. Connect with an HP technician by using online chat.

. Check for HP software updates.

You can also obtain support from the HP software for Windows or Mac OS X, which

provide easy, step-by-step solutions to common printing problems. For more
information, see Printer management tools.

Support options and availability vary by printer, country/region, and language.

HP support by phone

The phone support numbers and associated costs listed here are those in effect at time
of publication and are applicable only for calls made on a land line. Different rates may
apply for mobile phones.

For the most current HP list of telephone support numbers and call costs information,
see www.hp.com/support. This website provides information and utilities that can help
you correct many common printer problems.

During the warranty period, you may obtain assistance from the HP Customer Care
Center.

Br NOTE: HP does not provide telephone support for Linux printing. All support is
provided online at the following website: https://launchpad.net/hplip. Click the Ask
a question button to begin the support process.

The HPLIP website does not provide support for Windows or Mac OS X. If you are
using these operating systems, see www.hp.com/support. This website provides
information and utilities that can help you correct many common printer problems.

This section contains the following topics:
. Before you call

. Phone support period

. After the phone support period

Before you call

Call HP support while you are in front of the computer and the printer. Be prepared to
provide the following information:

. Model number
. Serial number (located on the back or bottom of the printer)
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. Messages that appear when the situation occurs
. Answers to these questions:
° Has this situation happened before?
° Can you re-create it?
° Did you add any new hardware or software to your computer at about the
time that this situation began?
° Did anything else occur prior to this situation (such as a thunderstorm or
moving the printer)?

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin
America (including Mexico).

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help
may also be available at the HP online support website: www.hp.com/support. This
website provides information and utilities that can help you correct many common
printer problems. Contact your HP dealer or call the support phone number for your
country/region to learn more about support options.

General troubleshooting tips and resources

Bf NOTE: Many of the following steps require HP software. If you did not install the
HP software, you can install it using the HP software CD included with the printer,
or you can download the HP software from the HP support website www.hp.com/
support. This website provides information and utilities that can help you correct
many common printer problems.

Check or do the following before you begin troubleshooting:

. Try turning the printer off and then on again.

. For a paper jam, see Clear jams.

. For paper-feed problems, such as the paper skew and paper pick, see Solve
paper-feed problems.

ILI_J (Power button) light is on and not blinking. When the printer is turned on for
the first time, it takes approximately 12 minutes to initialize it after the ink
cartridges are installed.

. Power cord and other cables are working, and are firmly connected to the printer.
Make sure the printer is connected firmly to a functioning alternating current (AC)
power outlet, and is turned on. For voltage requirements, see Electrical
specifications.

. Media is loaded correctly in the input tray and is not jammed in the printer.

. All packing tapes and materials are removed.

. The printer is set as the current or default printer. For Windows, set it as the

default in the Printers folder. For Mac OS X, set it as the default in the Print &

Fax or Print & Scan section of the System Preferences. See your computer's

documentation for more information.
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. Pause Printing is not selected if you are using a computer running Windows.

. You are not running too many programs when you are performing a task. Close
programs that you are not using or restart the computer before attempting the
task again.

Solve printer problems

Q TIP: You can visit the HP online support website at www.hp.com/support for
information and utilities that can help you correct many common printer problems.

This section contains the following topics:

. The printer shuts down unexpectedly

. Alignment fails

. The printer is not responding (nothing prints)

. The printer prints slowly

. The printer is making some unexpected noises
. Blank or partial page printed

. Something on the page is missing or incorrect
. Placement of the text or graphics is wrong

The printer shuts down unexpectedly

Check the power and power connections

Make sure the printer is connected firmly to a functioning alternating current (AC)
power outlet. For voltage requirements, see Electrical specifications.

Alignment fails

If the alignment process fails, make sure you have loaded unused, plain white paper
into the input tray. If you have colored paper loaded in the input tray when you align the
printer, the alignment fails.

If the alignment process fails repeatedly, you may need to clean the printhead, or you
might have a defective sensor. To clean the printhead, see Clean the printhead.

If cleaning the printhead does not solve the problem, contact HP support. Go to
www.hp.com/support. This website provides information and utilities that can help you
correct many common printer problems. If prompted, select your country/region, and
then click Contact HP for information on calling for technical support.

The printer is not responding (nothing prints)

There are print jobs stuck in the print queue

Open the print queue, cancel all documents, and then reboot the computer. Try to print
after the computer reboots. Refer to the Help system for the operating system for more
information.

Check the printer setup
For more information, see General troubleshooting tips and resources.
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Check the HP software installation

If the printer is turned off when printing, an alert message should appear on your
computer screen; otherwise, the HP software provided with the printer might not be
installed correctly. To resolve this, uninstall the HP software completely, and then
reinstall the HP software. For more information, see Uninstall and reinstall the HP
software.

Check the cable connections
. Make sure both ends of the USB cable or Ethernet cable are secure.
. If the printer is connected to a network, check the following:
° Check the Link light on the back of the printer.
° Make sure you are not using a phone cord to connect the printer.

Check any personal firewall software installed on the computer

The personal software firewall is a security program that protects a computer from
intrusion. However, the firewall might block communication between the computer and
the printer. If there is a problem communicating with the printer, try temporarily
disabling the firewall. If the problem persists, the firewall is not the source of the
communication problem. Re-enable the firewall.

The printer prints slowly

Try the following solutions if the printer is printing very slowly.
. Solution 1: Use a lower print quality setting

. Solution 2: Check the ink levels

. Solution 3: Contact HP support

Solution 1: Use a lower print quality setting

Solution: Check the print quality setting. Best and Maximum dpi provide the
best quality but are slower than Normal or Draft. Draft provides the fastest print
speed.

Cause: The print quality was set to a high setting.

If this did not solve the issue, try the next solution.

Solution 2: Check the ink levels

Solution: Check the estimated ink levels in the ink cartridges.

Br NOTE: Ink level alerts and indicators provide estimates for planning
purposes only. When you receive a low on ink message, consider having a
replacement cartridge available to avoid possible printing delays. You do not
need to replace the ink cartridges until prompted to do so.
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NOTE: The printer can operate with one or more depleted cartridges.
However, printing with depleted cartridges slows the printer and affects the
quality of printed documents. If the black cartridge is depleted, blacks are not
as dark. If a color cartridge is depleted, output is in grayscale. When possible,
replace the depleted cartridge. Do not remove the depleted cartridge until you
have a new ink cartridge available. For information about how to install new
cartridges, see Replace the ink cartridges.

/A CAUTION: While ink cartridges are not damaged when left outside of the
printer, the printhead does need to have all cartridges installed at all times
after the printer is set up and in use. Leaving one or more cartridge slots
empty for an extended period may lead to print quality problems and possibly
damage the printhead. If you have recently left a cartridge out of the printer
for an extended period, or if you have had a recent paper jam, and have
noticed poor print quality, clean the printhead. For more information, see
Clean the printhead.

For more information, see:

Check the estimated ink levels

Cause: The ink cartridges might have insufficient ink. Printing with depleted
cartridges slows the printer.

If this did not solve the issue, try the next solution.

Solution 3: Contact HP support
Solution: Contact HP support for service.

Go to: www.hp.com/support. This website provides information and utilities that
can help you correct many common printer problems.

If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.

Cause: There was a problem with the printer.

The printer is making some unexpected noises

You might hear some unexpected noises made by the printer. These are the servicing
sounds when the printer performs automatic servicing functions to maintain the health
of the printhead.

2,

[ NOTE: To prevent any potential damage to your printer:

Do not turn off the printer while the printer is performing any servicing. If you are
turning off the printer, wait for the printer to come to a complete stop before turning

it off using the IL_I_J (Power button). For more information, see Turn the printer off.

Make sure all ink cartridges are installed. If any of the ink cartridge is missing, the
printer will perform extra servicing to protect the printhead.
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Blank or partial page printed

Clean the printhead

Complete the printhead cleaning procedure. For more information, see Clean the
printhead. The printhead may need to be cleaned if the printer was turned off
incorrectly.

Br NOTE: Incorrectly turning off the printer can cause print quality problems like
blank or partial pages. Printhead cleaning can solve these problems, but turning off
the printer correctly can prevent them in the first place. Always turn the printer off

by pressing the ILI_J (Power button) on the printer. Wait until the LI_J (Power button)
light goes out before unplugging the power cord or turning off a power strip.

Check the media settings

. Make sure you select the correct print quality settings in the printer driver for the
media loaded in the trays.

. Make sure the page settings in the printer driver match the page size of media
loaded in the tray.

More than one page is being picked
For more information, see Solve paper-feed problems.

There is a blank page in the file
Check the file to make sure there is no blank page.

Something on the page is missing or incorrect

Check the Print Quality Diagnostic page

Print a Print Quality Diagnostic page to help you decide whether to run any
maintenance tools to improve the print quality of your printouts. For more information,
see Print quality troubleshooting.

Check the margin settings

Make sure the margin settings for the document do not exceed the printable area of the
printer. For more information, see Set minimum margins.

Check the color print settings
Make sure Print in Grayscale is not selected in the printer driver.

Check the printer location and length of USB cable

High electromagnetic fields (such as those generated by USB cables) can sometimes
cause slight distortions to printouts. Move the printer away from the source of the
electromagnetic fields. Also, it is recommended that you use a USB cable that is less
than 3 meters (9.8 feet) long to minimize the effects of these electromagnetic fields.
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Placement of the text or graphics is wrong

Check how the media is loaded

Make sure the media width and length guides fit snugly against the edges of the stack
of media, and make sure the tray is not overloaded. For more information, see Load
paper.

Check the media size

. Content on a page might be cut off if the document size is larger than the media
that you are using.

. Make sure the media size selected in the printer driver match the size of media
loaded in the tray.

Check the margin settings
If the text or graphics are cut off at the edges of the page, make sure the margin

settings for the document do not exceed the printable area of your printer. For more
information, see Set minimum margins.

Check the page-orientation setting

Make sure the media size and page orientation selected in the application match the
settings in the printer driver. For more information, see Print.

Check the printer location and length of USB cable

High electromagnetic fields (such as those generated by USB cables) can sometimes
cause slight distortions to printouts. Move the printer away from the source of the
electromagnetic fields. Also, it is recommended that you use a USB cable that is less
than 3 meters (9.8 feet) long to minimize the effects of these electromagnetic fields.

If the above solutions do not work, the problem may be caused by the inability of the
application to interpret print settings correctly. See the release notes for known
software conflicts, refer to the application's documentation, or contact the software
manufacturer for specific help.

Print quality troubleshooting

Try the solutions in this section to resolve print quality problems in your printout.

Q TIP: You can visit the HP online support website at www.hp.com/support for
information and utilities that can help you correct many common printer problems.

. Solution 1: Make sure you are using original HP ink cartridges
. Solution 2: Check the ink levels

. Solution 3: Check the paper loaded in the input tray

. Solution 4: Check the paper type

. Solution 5: Check the print settings

. Solution 6: Print and evaluate a print quality report

. Solution 7: Contact HP support
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Solution 1: Make sure you are using original HP ink cartridges
Solution: Check to see if your ink cartridges are original HP ink cartridges.

HP recommends that you use original HP ink cartridges. Original HP ink
cartridges are designed and tested with HP printers to help you easily produce
great results, time after time.

B NOTE: HP cannot guarantee the quality or reliability of non-HP supplies.
Printer service or repairs required as a result of using a non-HP supply are
not covered under warranty.

If you believe you purchased original HP ink cartridges, go to:
www.hp.com/go/anticounterfeit

Cause: Non-HP ink cartridges were being used.
If this did not solve the issue, try the next solution.

Solution 2: Check the ink levels

Solution: Check the estimated ink levels in the ink cartridges.

B NOTE: Ink level alerts and indicators provide estimates for planning
purposes only. When you receive a low-ink alert, consider having a
replacement cartridge available to avoid possible printing delays. You do not
need to replace the ink cartridges until prompted to do so.

NOTE: The printer can operate with one or more depleted cartridges.
However, printing with depleted cartridges slows the printer and affects the
quality of printed documents. If the black cartridge is depleted, blacks are not
as dark. If a color cartridge is depleted, output is in grayscale. When possible,
replace the depleted cartridge. Do not remove the depleted cartridge until you
have a new ink cartridge available. For information about how to install new
cartridges, see Replace the ink cartridges.

/\ CAUTION: While ink cartridges are not damaged when left outside of the
printer, the printhead does need to have all cartridges installed at all times
after the printer is set up and in use. Leaving one or more cartridge slots
empty for an extended period may lead to print quality problems and possibly
damage the printhead. If you have recently left a cartridge out of the printer
for an extended period, or if you have had a recent paper jam, and have
noticed poor print quality, clean the printhead. For more information, see
Clean the printhead.

For more information, see:
Check the estimated ink levels

Cause: The ink cartridges might have insufficient ink.
If this did not solve the issue, try the next solution.
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Solution 3: Check the paper loaded in the input tray
Solution: Make sure the paper is loaded correctly and that it is not wrinkled or
too thick.

. Load paper with the print side facing down. For example, if you are loading
glossy photo paper, load the paper with the glossy side down.

. Make sure the paper lays flat in the input tray and is not wrinkled. If the
paper is too close to the printhead during printing, the ink might be
smeared. This can happen if the paper is raised, wrinkled, or very thick,
such as a mailing envelope.

For more information, see:
Load paper.
Cause: The paper was loaded incorrectly, or it was wrinkled or too thick.

If this did not solve the issue, try the next solution.

Solution 4: Check the paper type

Solution: HP recommends that you use HP papers or any other paper type
with ColorLok technology that is appropriate for the printer. All papers with the
ColorLok logo are independently tested to meet high standards of reliability and
print quality, and produce documents with crisp, vivid color, bolder blacks and dry
faster than ordinary plain papers.

Always make sure the paper you are printing on is flat. For best results when
printing images, use HP Advanced Photo Paper.

Store specialty media in its original packaging inside a resealable plastic bag on a
flat surface in a cool, dry place. When you are ready to print, remove only the
paper you plan to use immediately. When you have finished printing, return any
unused photo paper to the plastic bag. This prevents the photo paper from
curling.

149,

¥ NOTE: For this issue, there is not a problem with your ink supplies.
Therefore, replacing the ink cartridges is not necessary.

For more information, see:

Select paper
Cause: The wrong kind of paper was loaded in the input tray.

If this did not solve the issue, try the next solution.
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Solution 5

: Check the print settings

Solution: Check the print settings.

Check the print settings to see if the color settings are incorrect.

For example, check to see if the document is set to print in grayscale. Or,
check to see if advanced color settings such as saturation, brightness, or
color tone, are set to modify the appearance of colors.

Check the print quality setting and make sure it matches the type of paper
loaded in the printer.

You might need to choose a lower print quality setting if colors are running
into each other. Or, choose a higher setting if you are printing a high-quality
photo, and then make sure photo paper such as HP Advanced Photo Paper
is loaded in the input tray.

B NOTE: On some computer screens, colors might appear differently than they
do when printed on paper. In this case, there is nothing wrong with the printer,
print settings, or ink cartridges. No further troubleshooting is required.

For more information, see:

Select paper

Caus
If this

Solution 6

e: The print settings were set incorrectly.
did not solve the issue, try the next solution.

: Print and evaluate a print quality report

Solution:

To print a print quality report

Solve a problem

Control panel: Touch e (right arrow), and then touch Setup, select
Reports, and then select Print Quality Report.

Embedded web server: Click the Tools tab, click Print Quality Toolbox
under Utilities, and then click Print Quality Report button.

HP Utility (Mac OS X): In the Information And Support section, click
Print Quality Diagnostics, and then click Print.
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If defects are seen on the Print Quality Diagnostic report, follow the steps below:

1. If the Print Quality Diagnostic report shows faded, partial, streaked, or
missing color bars or patterns, check for depleted ink cartridges, and
replace the ink cartridge that corresponds to the defective color bar or color
pattern. If there is no depleted ink cartridge, remove and reinstall all ink
cartridges to make sure they are properly installed. Do not remove the
depleted cartridge until you have a new ink cartridge available to replace.
For information about how to install new cartridges, see Replace the ink
cartridges.

Calibrate the linefeed. For more information, see Calibrate the linefeed.

Align the printhead. For more information, see Align the printhead.
Clean the printhead. For more information, see Clean the printhead.

If none of the previous steps have helped, contact HP support to replace the
printhead. For more information, see HP support.

ok oNDN

Cause: Print quality problems can have many causes: software settings, a poor
image file, or the printing system itself. If you are unhappy with the quality of your
prints, a Print Quality Diagnostic page can help you determine if the printing
system is working correctly.

Solution 7: Contact HP support
Solution: Contact HP support for service.
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Go to: www.hp.com/support. This website provides information and utilities that
can help you correct many common printer problems.

If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.

Cause: There was a problem with the printhead.

Solve paper-feed problems

Q TIP: You can visit the HP online support website at www.hp.com/support for

information and utilities that can help you correct many common printer problems.

Media is not supported for the printer or tray

Use only media that is supported for the printer and the tray being used. For more
information, see Paper specifications.

Media is not picked up from a tray

Make sure media is loaded in the tray. For more information, see Load paper.
Fan the media before loading.

Make sure the paper guides are set to the correct markings in the tray for the
media size you are loading. Also make sure the guides are snug, but not tight,
against the stack.

Make sure media in the tray is not curled. Uncurl paper by bending it in the
opposite direction of the curl.

Media is not coming out correctly

Make sure the output tray extension is fully extended; otherwise, printed pages
may fall off the printer.

Remove excess media from the output tray. There is a limit to the number of
sheets the tray can hold.
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Pages are skewing

Make sure the media loaded in the trays is aligned to the paper guides. If needed,
pull out the trays from the printer and reload the media correctly, making sure that
the paper guides are aligned correctly.

Load media into the printer only when it is not printing.

Remove and replace the automatic two-sided printing accessory (duplexer).

° Push the button on either side of the duplexer, and then remove the unit.

° Reinsert the duplexer into the printer.

Multiple pages are being picked up

Fan the media before loading.

Make sure the paper guides are set to the correct markings in the tray for the
media size you are loading. Also make sure the guides are snug, but not tight,
against the stack.

Make sure the tray is not overloaded with paper.

When using thin special media, make sure that the tray is completely loaded. If
you are using special media that is only available in small quantities, try placing
the special media on top of other paper of the same size to help fill the tray.
(Some media is picked up more easily if the tray is full.)

If you are using thick special media (such as brochure paper), load media so that
the tray is between 1/4 and 3/4 full. If necessary, place the media on top

of other paper of the same size so that the stack height is within this range.
Use HP media for optimum performance and efficiency.

Solve problems using Web Services and HP websites

This section provides solutions to common problems using Web Services and HP
websites.

Solve problems using Web Services
Solve problems using HP websites
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Solve problems using Web Services
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If you are having problems using Web Services, such as HP ePrint and Printer Apps,
check the following:

Make sure the printer is connected to the Internet using an Ethernet or wireless
connection.

B NOTE: You cannot use these web features if the printer is connected using a
USB cable.

Make sure the latest product updates have been installed on the printer. For more

information, see Update the printer.

Make sure Web Services is enabled on the printer. For more information, see Set

up Web Services using the printer’s control panel.

Make sure the network hub, switch, or router is turned on and working correctly.

If you are connecting the printer using an Ethernet cable, make sure you are not

connecting the printer using a phone cord or a crossover cable to connect the

printer to the network and that the Ethernet cable is securely connected to the

printer. For more information, see Solve Ethernet network problems.

If you are connecting the printer using a wireless connection, make sure the

wireless network is functioning properly. For more information, see Solve wireless

problems.

If you are using HP ePrint, check the following:

° Make sure the printer's email address is correct.

° Make sure that the printer’'s email address is the only address listed in the
“To” line of the email message. If other email addresses are listed in the
“To” line, the attachments you are sending might not print.

° Make sure you are sending documents that meet the HP ePrint
requirements. For more information, see Web Services specifications.

If your network uses proxy settings when connecting to the Internet, make sure

the proxy settings you are entering are valid:

° Check the settings being used by the Web browser you are using (such as
Internet Explorer, Firefox, or Safari).

° Check with the IT administrator or person who set up your firewall.
If the proxy settings used by your firewall have changed, you must update
these settings in either the printer’s control panel. If these settings are not
updated, you will not be able to use Web Services.
For more information, see Set up Web Services using the printer’s control
panel.

0> TIP: For additional help on setting up and using Web Services, visit HP
Connected (www.hpconnected.com).
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Solve problems using HP websites

If you are having problems using HP websites from your computer, check the following:

. Make sure the computer that you are using is connected to the Internet.

. Make sure the web browser meets the minimum system requirements. For more
information, see HP website specifications.

. If your web browser uses any proxy settings to connect to the Internet, try turning
off these settings. For more information, see the documentation provided with
your web browser.

Solve memory device problems

Q TIP: You can visit the HP online support website at www.hp.com/support for
information and utilities that can help you correct many common printer problems.

Br NOTE: If you are starting a memory device operation from a computer, see the
software Help for troubleshooting information.

. The printer cannot read the memory device

. The printer cannot read photos on the memory device

The printer cannot read the memory device
. Check the memory device

o

Make sure that the memory device is one of the supported types. For more
information, see Memory device specifications.

Some memory devices have a switch that controls how they can be used.
Make sure that the switch is set so that the memory device can be read.
Inspect the ends of the memory device for dirt or material that closes a hole
or spoils a metal contact. Clean the contacts with a lint-free cloth and small
amounts of isopropyl alcohol.

Make sure that the memory device is working correctly by testing it with
other devices. If the files can be access using a computer, the device may
still not work with the printer.

. Check the USB port

o

[

Make sure that the USB cable is fully inserted into the port.

Remove the USB cable and shine a flashlight into the empty port. See if
there is any debris in the port. For more information, see HP support. This
website provides information and utilities that can help you correct many
common printer problems.

The printer cannot read photos on the memory device
Check the memory device
The memory device might be corrupt.

Solve memory device problems 65


http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-001&h_page=hpcom&h_client=s-h-e008-1&h_product=5081821&h_lang=en&h_cc=us

Chapter 5

Solve Ethernet network problems

Q TIP: You can visit the HP online support website at www.hp.com/support for
information and utilities that can help you correct many common printer problems.

If you are unable to connect the printer to your Ethernet network, perform one or more
of the following tasks.

Bf NOTE: After correcting any of the following, run the installation program again.

. General network troubleshooting

General network troubleshooting
If you are unable to install the HP software provided with the printer, verify that:
. All cable connections to the computer and the printer are secure.
. The network is operational and the network hub, switch, or router is turned on.

. All applications, including virus protection programs, spyware protection
programs, and firewalls, are closed or disabled for computers running Windows.

. The printer is installed on the same subnet as the computers that use the printer.

Solve wireless problems

This section provides information about solving problems you might encounter when
connecting the printer to your wireless network.

Follow these suggestions in order, starting with those listed in the "Basic wireless
troubleshooting" section. If you still encounter problems, follow the suggestions
provided in the "Advanced wireless troubleshooting" section.

This section contains the following topics:

. Basic wireless troubleshooting
. Advanced wireless troubleshooting
. After resolving the problems

- TIP: For more information about troubleshooting wireless problems, visit the HP
Wireless Printing Center www.hp.com/go/wirelessprinting.

B NOTE: After you resolve the problem, follow the instructions in After resolving the
problems.

Basic wireless troubleshooting

Bf NOTE: If you have not configured the printer for wireless connection, use the HP
software to complete the setup. For more information, see .

Perform the following steps in the order presented.
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Q- TIP: If you are using a computer running Windows, use the HP Print and Scan
" Doctor to help diagnose and get assistance in installing and using HPprinters on
home network. To use this tool, visit the HP Wireless Printing Center www.hp.com/
go/wirelessprinting.

Step 1 - Make sure the wireless (802.11) light is turned on

The Wireless light in the printer control panel indicates the status of the wireless
capabilities.

To turn on wireless, touch e (right arrow), touch Setup, touch Network, touch
Wireless Radio, and then select Yes.

Br NOTE: If your printer supports Ethernet networking, make sure that an Ethernet
cable has not been connected to the printer. Connecting an Ethernet cable turns off
the printer's wireless capabilities.

Step 2 - Restart components of the wireless network

Turn off the router and the printer, and then turn them back on in this order: router first
and then the printer. If you still are unable to connect, turn off the router, printer, and
your computer. Sometimes, turning off the power and then turning it back on recovers
from a network communication issue.

Step 3 - Run the Print Wireless Network Test

For wireless networking issues, run the Print Wireless Network Test. If a problem is
detected, the printed test report includes recommendations that might help solve the
problem.

Q TIP: If the Print Wireless Network Test indicates the signal is weak, try moving the
printer closer to the wireless router.

To print a wireless network test page
1.  Touch e (right arrow), touch Setup, and then touch Network.
2. Touch ¥ (down arrow), and then select Print Wireless Test Report.

Advanced wireless troubleshooting

If you have tried the suggestions provided in Basic wireless troubleshooting and are
still unable to connect to your printer to the wireless network, try the following
suggestions in the order presented:

. Step 1 - Make sure your computer is connected to your network
. Step 2 - Make sure that the printer is connected to your network

. Step 3 - Make sure your computer is not connected to your network over a Virtual
Private Network (VPN)

. Step 4 - Make sure the printer is online and ready

. Step 5 - Make sure the wireless version of the printer is set as the default printer
driver (Windows only)

. Step 6 - Check to see if the firewall software is blocking communication
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Step 1 - Make sure your computer is connected to your network

Make sure your computer is connected to your network - either your Ethernet network
or your wireless network. If the computer is not connected to the network, you cannot
use the printer over the network.

To check an Ethernet connection

Many computers have indicator lights beside the port where the Ethernet cable
connects to your computer. If the lights are not on, try reconnecting the Ethernet cable
to the computer and the router. If you still do not see lights, there might be a problem
with the router, the Ethernet cable, or your computer.

Bf NOTE: Mac computers do not have indicator lights. To check the Ethernet
connection on a Mac, click System Preferences in the Dock, and then click
Network. If the Ethernet connection is working correctly, Built-in Ethernet appears
in the list of connections, along with the IP address and other status information. If
Built-in Ethernet does not appear in the list, there might be a problem with the
router, the Ethernet cable, or your computer. For more information, click the Help
button in the window.

To check a wireless connection

1.  Make sure that your computer's wireless has been turned on. (For more
information, see the documentation that came with your computer.)

2. Ifyou are not using a unique wireless network name (SSID), then it is possible
that your wireless computer could be connected to a nearby network that is not
yours.

The following steps can help you determine if your computer is connected to your
network:

Windows

a. Click Start, click Control Panel, point to Network Connections, and then
click View Network Status and Tasks.
-Or-
Click Start, select Settings, click Control Panel, double-click Network
Connections, click the View menu, and then select Details.
Leave the network dialog box open while you continue to the next step.

b. Disconnect the power cord from the wireless router. The connection status
of your computer should change to Not Connected.

c. Reconnect the power cord to the wireless router. The connection status
should change to Connected.
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Mac OS X

A Click the AirPort icon in the menu bar at the top of the screen. From the
menu that appears, you can determine if the AirPort is turned on and which
wireless network your computer is connected to.

B NOTE: For more detailed information about your AirPort connection,
click System Preferences in the Dock, and then click Network. If the
wireless connection is working correctly, a green dot appears next to
AirPort in the list of connections. For more information, click the Help
button in the window.

If you are unable to get your computer connected to your network, contact the person
who set up your network or the router manufacturer as there might be a hardware
issue with either your router or computer.

Q- TIP: If you are able to access the Internet and are using a computer running
" Windows, you can also use the HP Network Assistant for help in setting up a
network. To use this tool, visit www.hp.com/sbso/wireless/tools-setup.html|?
jumpid=reg_R1002_USEN. (This Web site is only available in English.)

Step 2 - Make sure that the printer is connected to your network

If your printer is not connected to the same network as your computer, you cannot use
the printer over the network. Follow the steps described in this section to find out if your
printer is actively connected to the correct network.

Br NOTE: If your wireless router or Apple AirPort Base Station is using a hidden
SSID, your printer cannot automatically detect the network.

A: Make sure the printer is on the network

1.  If the printer supports Ethernet networking and is connected to an Ethernet
network, make sure an Ethernet cable is not plugged into the back of the printer.
If an Ethernet cable is plugged into the back, then wireless connectivity is
disabled.

2. Ifthe printer is connected to a wireless network, print the network configuration
page. For more information, see Understand the network configuration page.

3.  After the page has been printed, check the Network Status and URL:

Network Status . If the Network Status is Ready, the
printer is actively connected to a
network.

. If the Network Status is Offline, the
printer is not connected to a network.
Run the Print Wireless Network Test
(using the instructions at the
beginning of this section) and follow
any recommendations.

URL The URL shown here is the network
address assigned to the printer by your
router. You need this to connect to the
embedded web server (EWS).
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For information about connecting the printer to a wireless network, see Set up the
printer for wireless communication.

B: Check to see if you can access the EWS

After you establish that the computer and the printer both have active connections to a
network, you can verify if they are on the same network by opening the printer's EWS.
For more information, see Embedded web server.

To access the EWS

1. On your computer, open the EWS. For more information, see Embedded web
server.

B NOTE: If you are using a proxy server in your browser, you might need to
disable it to access the EWS.

2. If you can open the EWS, try using the printer over the network (such as to print)
to see if your network setup was successful.

If you cannot open the EWS or are still having problems using the printer over the
network, continue to the next section regarding firewalls.

Step 3 - Make sure your computer is not connected to your network over a
Virtual Private Network (VPN)

A Virtual Private Network (VPN) is a computer network that uses the Internet to provide
a remote, secure connection to an organization’s network. However, most VPN
services do not allow you to access local devices (like your printer) on your local
network while your computer is connected to the VPN.

To connect to the printer, disconnect from the VPN.

Q TIP: To use the printer while connected to the VPN, you can connect the printer to
your computer with a USB cable. The printer uses its USB and network
connections at the same time.

For more information, contact your network administrator or the person who set up the
wireless network.

Step 4 - Make sure the printer is online and ready

If you have the HP software installed, you can check the printer’s status from your
computer to see if the printer is paused or offline, preventing you from using it.

To check the printer’s status, follow the instructions for your operating system:

Windows

1.  Click Start, and then click Printers or Printers and Faxes or Devices and
Printers.
- Or -

Click Start, click Control Panel, and then double-click Printers.

2. If the printers on your computer are not being displayed in Details view, click the
View menu, and then click Details.
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3. Do one of the following, depending on the printer status:
a. If the printer is Offline, right-click the printer, and click Use Printer Online.
b. If the printer is Paused, right-click the printer, and click Resume Printing.
4. Try using the printer over the network.

Mac OS X
1.  Click System Preferences in the Dock, and then click Print & Fax or Print &
Scan.

2.  Select the printer, and then click Open Print Queue.

3. Ifthe print job is on hold, click Resume.

4. If the printer is paused, click Resume Printer.

If you can use the printer after performing the steps above but find that the symptoms

persist as you continue to use the printer, your firewall might be interfering. For more
information, see Configure your firewall software to work with the printer.

If you still cannot use the printer over the network, continue to the next section for
additional troubleshooting help.

Step 5 - Make sure the wireless version of the printer is set as the default printer
driver (Windows only)

If you install the HP software again, the installer might create a second version of the
printer driver in your Printers or Printers and Faxes or Devices and Printers folder. If
you have difficulties printing or connecting to the printer, make sure the correct version
of the printer driver is set as the default.
1. Click Start, and then click Printers or Printers and Faxes or Devices and
Printers.
-Or-
Click Start, click Control Panel, and then double-click Printers.
2. Determine if the version of the printer driver in the Printers or Printers and
Faxes or Devices and Printers folder is connected wirelessly:
a. Right-click the printer icon, and then click Printer Properties, Document
Defaults, or Printing Preferences.
b. On the Ports tab, look for a port in the list with a checkmark. The version of
the printer driver that is connected wirelessly has HP network re-discovery
port monitor as the Port description, next to the checkmark.

3. Right-click the printer icon for the version of the printer driver that is connected
wirelessly, and select Set as Default Printer.

Br NOTE: If there is more than one icon in the folder for the printer, right-click the
printer icon for the version of the printer driver that is connected wirelessly, and
select Set as Default Printer.

Step 6 - Check to see if the firewall software is blocking communication

If you cannot access the EWS and are sure both the computer and printer have active
connections to the same network, the firewall security software might be blocking
communication. Temporarily turn off any firewall security software running on your
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computer and then try to open the EWS again. If you can open the EWS, try using the
printer (for printing).

If you are able to open the EWS and use your printer with the firewall turned off, you
need to reconfigure your firewall settings to allow the computer and printer to
communicate with each other over the network. For more information, see Configure
your firewall software to work with the printer.

If you are able to open the EWS, but are still unable to use the printer even with the
firewall turned off, try enabling the firewall software to recognize the printer. For more
information, see the documentation provided with your firewall software.

After resolving the problems

After you resolve any problems and have successfully connected the printer to your
wireless network, complete the following steps for your operating system:

Windows

1.  On the computer desktop, click Start, select Programs or All Programs, click
HP, click the name fo the folder, and then click Printer Setup & Software.
-Or-
On the Start screen, click Printer Setup & Software.

2. Click Connect a new printer, and then select the type of connection you want to
use.

Mac OS X
1.  Open HP Utility. For more information, see HP Utility (Mac OS X).

2.  Click the Applications icon on the HP Ultility toolbar, double-click HP Setup
Assistant, and then follow the onscreen instructions.

Configure your firewall software to work with the printer

A personal firewall, which is security software running on your computer, can block
network communication between your printer and your computer.

If you are having problems such as:

. Printer not found when installing HP software
. Unable to print, print job stuck in queue or printer goes offline
. Unable to see printer status on your computer

The firewall might be preventing your printer from notifying computers on your network
where it can be found.

If you are using the HP software on a computer running Windows and cannot find the
printer during installation (and you know the printer is on the network)—or if you have
already successfully installed HP software and experience problems—check the
following:

. If you have just installed the HP software, try turning off your computer and the
printer, and then turning them both on again.

. Keep your security software up to date. Many security software vendors provide
updates that correct known issues and provide the latest defenses against new
security threats.
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. If your firewall has "High", "Medium", or "Low" security settings, use the "Medium"
setting when your computer is connected to your network.

. If you have changed any firewall settings from default, try going back to the
default setting.

. If your firewall has a setting called "trusted zone", use this setting when your
computer is connected to your network.

. If your firewall has a setting to "not show alert messages", you should disable

this. When installing the HP software and using the HP printer you may see alert
messages from your firewall software that provide options to "allow", "permit" or
"unblock". You should allow any HP software that causes an alert. Also, if the
alert has a "remember this action" or "create a rule for this" selection, select it.

This is how the firewall learns what can be trusted on your network.

. Do not have more than one firewall enabled at the same time on your computer.
An example would be having both the Windows firewall provided by the operating
system and a 3rd party firewall enabled at the same time. Having more than one
firewall enabled at the same time will not make your computer any safer and may
cause problems.

For more information about using your printer with personal firewall software, visit
www.hp.com/go/wirelessprinting, and then click Firewall Help in the Need Help
Troubleshooting? section. The Firewall Help section also includes workarounds for
known issues with some firewalls.

2,

[ NOTE: At this time, some portions of this site are not available in all languages.

Solve printer management problems

Q TIP: You can visit the HP online support website at www.hp.com/support for
information and utilities that can help you correct many common printer problems.

This section provides solutions to common problems that involve managing the printer.
This section contains the following topic:

. Embedded web server cannot be opened

|§/f’ NOTE: To use the embedded EWS, the printer must be connected to a network
using either an Ethernet or a wireless connection. You cannot use the embedded
web server if the printer is connected to a computer with a USB cable.

Embedded web server cannot be opened

Check your network setup

. Make sure you are not using a phone cord or a crossover cable to connect the
printer to the network.

. Make sure the network cable is securely connected to the printer.
. Make sure the network hub, switch, or router is turned on and working correctly.

Check the computer
Make sure the computer that you are using is connected to the network.
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Bf NOTE: To use the EWS, the printer must be connected to a network using either

an Ethernet or a wireless connection. You cannot use the embedded web server if
the printer is connected to a computer with a USB cable.

Check your web browser

Make sure the web browser meets the minimum system requirements. For more
information, see Embedded web server specifications.

If your web browser uses any proxy settings to connect to the Internet, try turning
off these settings. For more information, see the documentation available with
your web browser.

Make sure JavaScript and cookies are enabled in your web browser. For more
information, see the documentation available with your web browser.

Check the printer IP address

To check the IP address of the printer, obtain the IP address by printing a
network configuration page. Touch e (right arrow), select Setup, select Network,
and then select Print Network Settings.

Ping the printer using the IP address from the command prompt (Windows) or
from Network Utility (Mac OS X). (Network Utility is located in the Utilities folder
in the Applications folder at the top level of the hard disk.).

For example, if the IP address is 123.123.123.123, type the following at the
command prompt (Windows):

C:\Ping 123.123.123.123

—Or-

In Network Utility (Mac OS X), click the Ping tab, type the 123.123.123.123 in the
box, and then click Ping.

If a reply appears, the IP address is correct. If a time-out response appears, the
IP address is incorrect.

Troubleshoot installation issues

Q TIP: You can visit the HP online support website at www.hp.com/support for

information and utilities that can help you correct many common printer problems.

Hardware installation suggestions
HP software installation suggestions

Hardware installation suggestions

Check the printer

Make sure that all packing tape and material have been removed from outside
and inside the printer.

Make sure that the printer is loaded with paper.

Make sure that no lights are on or blinking except the Ready light, which should
be on. If the Attention light is blinking, check for messages on the printer control
panel.
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Check the hardware connections

Make sure that any cords and cables that you are using are in good working
order.

Make sure that the power cord is connected securely to both the printer and to
a working power outlet.

Check the printhead and ink cartridges

Make sure that all of the printhead and ink cartridges are firmly installed in their
correct, color-coded slot. The printer cannot work if they are not all installed.

Make sure that the printhead latch is closed correctly.

HP software installation suggestions

Check the computer system

Make sure that your computer is running one of the supported operating systems.
For more information, see System requirements.

Make sure that the computer meets at least the minimum system requirements.
For more information, see System requirements

In the Windows Device Manager, make sure that the USB drivers have not been
disabled.

If you are using a computer running Windows, and the computer cannot detect
the printer, run the Uninstall utility (located in the printer's subfolder within the HP
folder) to perform a complete uninstallation of the printer driver. Restart your
computer, and reinstall the printer driver.

Verify installation preliminaries

2,

[ NOTE: After correcting any problems, run the installation program again.

Make sure to use the installation CD that contains the correct HP software for
your operating system.

Before installing HP software, make sure that all other programs are closed.

If the computer does not recognize the path to the CD-ROM drive that you type,
make sure that you are specifying the correct drive letter.

If the computer cannot recognize the installation CD in the CD-ROM drive,
inspect the installation CD for damage. You can download the printer driver from
the HP website (www.hp.com/support).

Solve network problems

General network troubleshooting

If you are unable to install the HP software, verify that:
° All cable connections to the computer and the printer are secure.

° The network is operational and the network hub, switch, or router is turned
on.
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° All applications, including virus protection programs, spyware protection
programs, and firewalls, are closed or disabled for computers running
Windows.

° Make sure the printer is installed on the same subnet as the computers that
use the printer.

° If the installation program cannot discover the printer, print the network
configuration page and enter the IP address manually in the installation
program. For more information, see Understand the network configuration
page.

If you installed the printer driver using the Add Printer wizard and specified the

TCP/IP port, make sure that the network ports created in the printer driver match

the printer IP address:

° Print the printer's network configuration page. For more information, see
Understand the network configuration page.

° Click Start, and then click Printers or Printers and Faxes or Devices and
Printers.

-Or-
Click Start, click Control Panel, and then double-click Printers.

° Right-click the printer icon, click Printer Properties, and then click the
Ports tab.

° Select the TCP/IP port for the printer, and then click Configure Port.

° Compare the IP address listed in the dialog box and make sure it matches
the IP address listed on the network configuration page. If the IP addresses
are different, change the IP address in the dialog box to match the address
on the network configuration page.

° Click OK twice to save the settings and close the dialog boxes.

Problems connecting to an Ethernet network

If the Link light on the network connector does not turn on, make sure that all of
the “General network troubleshooting” conditions are met.

Though it is not recommended that you assign the printer with a static IP address,
you might resolve some installation problems (such as a conflict with a personal
firewall) by doing so.

To reset the printer's network settings

1.

Touch e (right arrow), touch Setup, and then touch Network. Touch Restore
Network Defaults, and then select Yes. A message appears stating that the
network defaults have been restored.

Touch = (right arrow), touch Setup, select Reports, and then select Print
Network Configuration Page to print the network configuration page and verify
that the network settings have been reset.

Understand the Printer Status Report

Use the printer status report to view current printer information and ink cartridge status.
Also use the printer status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.
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If you need to call HP, it is often useful to print the printer status report before calling.
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1. Printer Information: Shows printer information (such as the printer name, model
number, serial number, and firmware version number), the accessories that are
installed (such as the automatic two-sided printing accessory or duplexer), and
the number of pages printed from the trays and accessories.

2. Ink Delivery System Information: Shows the estimated ink levels (represented
in graphical form as gauges) and the part numbers and warranty expiration dates
for the ink cartridges.

Bf NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider
having a replacement cartridge available to avoid possible printing delays.
You do not need to replace cartridges until prompted to do so.

3. Additional Assistance: Provides information about where you can go to get
more information about the printer, as well as information about how to set up a
Fax Text and how to run a Print Wireless Network Test.

To print the Printer Status Report

From the Home screen, touch e (right arrow), and then select Setup. Touch Reports,
and then select Printer Status Report.
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Printhead maintenance

If you are experiencing problems with printing, you might have a problem with the
printhead. You should perform the procedures in the following sections only when
directed to do so for resolving print quality issues.

Performing the aligning and cleaning procedures unnecessarily can waste ink and
shorten the life of the cartridges.

This section contains the following topics:
. Clean the printhead

. Calibrate the linefeed

. Align the printhead

. Reinstall the printhead

Clean the printhead

If your printed output is streaked or has any incorrect or missing colors, the printhead
might need to be cleaned.

There are three stages of cleaning. Each stage lasts about two minutes, uses one
sheet of paper, and uses an increasing amount of ink. After each stage, review the
quality of the printed page. You should only initiate the next phase of cleaning if the
print quality is poor.

If print quality still seems poor after you complete both stages of cleaning, try aligning
the printer. If print quality problems persist after cleaning and aligning, contact HP
support. For more information, see HP support.

Bf NOTE: Cleaning uses ink, so clean the printhead only when necessary. The
cleaning process takes a few minutes. Some noise might be generated in the
process. Before cleaning the printhead, make sure you load paper. For more
information, see Load paper.

Not turning the printer off correctly can cause print quality problems. For more
information, see Turn the printer off.

To clean the printhead from the control panel

1. Load Letter, A4, or Legal unused plain white paper into the main input tray.
2.  Touch p (right arrow), and then select Setup.

3. Touch Tools, and then select Clean Printhead.

To clean the printhead from Toolbox (Windows)

1. Open Toolbox. For more information, see Open the Toolbox.

2. From the Device Services tab, click the icon to the left of Clean Printheads.
3.  Follow the on-screen instructions.
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To clean the printhead from HP Utility (Mac OS X)

1.  Open HP Utility. For more information, see HP Utility (Mac OS X).
2. In the Information And Support section, click Clean Printheads.
3. Click Clean, and then follow the on-screen instructions.

To clean the printhead from the embedded web server (EWS)

1. Open the EWS. For more information, see To open the embedded web server.
2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.
3.  Click Clean Printhead and follow the on-screen instructions.

Calibrate the linefeed
The printer automatically aligns the printhead during the initial setup.

You might want to use this feature when the printer status page shows dark lines
through any of the blocks of color, or if you are having print quality issues with color
printouts.

To calibrate the linefeed from the control panel

1. Load Letter, A4, or Legal unused plain white paper into the main input tray.
2. On the printer control panel, touch e (right arrow), and then touch Setup.
3. Touch Tools, and then select Calibrate Linefeed.

To calibrate the linefeed from Toolbox (Windows)

1.  Open Toolbox. For more information, see Open the Toolbox.

2. From the Device Services tab, click the icon to the left of Linefeed Calibration.
3.  Follow the on-screen instructions.

To calibrate the linefeed from the embedded web server (EWS)

1. Open the EWS. For more information, see To open the embedded web server.
2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.
3. Click Calibrate Linefeed and follow the on-screen instructions.

Align the printhead
The printer automatically aligns the printhead during the initial setup.

You might want to use this feature when the printer status page shows streaking or
white lines through any of the blocks of color or if you are having print quality issues
with your printouts.

To align the printhead from the control panel

1. Load Letter, A4, or Legal unused plain white paper into the main input tray.
2. On the printer control panel, touch e (right arrow), and then touch Setup.
3. Touch Tools, and then select Align Printhead.
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To align the printhead from Toolbox (Windows)

1.  Open Toolbox. For more information, see Open the Toolbox.

2. From the Device Services tab, click the icon to the left of Align Printheads.
3. Follow the on-screen instructions.

To align the printhead from HP Utility (Mac OS X)

1. Open HP Utility. For more information, see HP Utility (Mac OS X).
2.  Inthe Information And Support section, click Align Printhead.
3.  Click Align, and then follow the on-screen instructions.

To align the printhead from the embedded web server (EWS)

1. Open the EWS. For more information, see To open the embedded web server.
2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.
3.  Click Align Printer and follow the on-screen instructions.

Reinstall the printhead

Bf NOTE: This procedure should only be performed when a Missing or Failed
Printhead message has been seen and the printer has first been turned off and
then back on to try to resolve the message. If the message persists, try this
procedure.

To reinstall the printhead
1.  Make sure that the printer is turned on.
2. Open the ink cartridge access door.
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Lift the latch handle on the print carriage.
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6.  Carefully lower the latch handle.

B NOTE: Make sure you lower the latch handle before reinserting the ink
cartridges. Leaving the latch handle raised can result in incorrectly seated ink
cartridges and problems printing. The latch must remain down in order to
correctly install the ink cartridges.

7. Close the ink cartridge access door.

Understand the network configuration page

If the printer is connected to a network, you can print a network configuration page to
view the network settings for the printer. You can use the network configuration page to
help troubleshoot network connectivity problems. If you need to call HP, it is often
useful to print this page before calling.
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General Information: Shows information about the current status and active
connection type of the network, and other information, such as the URL of the
embedded web server.

802.3 Wired: Shows information about the active Ethernet network connection,

such as the IP address, subnet mask, default gateway, as well as the hardware

address of the printer.

802.11 Wireless (some models): Shows information about your wireless

network connection, such as the hostname, IP address, subnet mask, default

gateway, and server.

Miscellaneous: Shows information about more advanced network settings.

. Port 9100: The printer supports raw IP printing through TCP Port 9100. This
HP-proprietary TCP/IP port on the printer is the default port for printing. It is
accessed by HP software (for example, the HP Standard Port).

. LPD: Line Printer Daemon (LPD) refers to the protocol and programs
associated with line-printer spooling services that may be installed on
various TCP/IP systems.

B NOTE: The LPD functionality can be used with any host
implementation of LPD that complies with the RFC 1179 document. The
process for configuring printer spoolers, however, might differ. See your
system documentation for information about configuring these systems.

. Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name
System) are typically used on small networks for IP address and name
resolution (through UDP port 5353), where a conventional DNS server is not
used.

. SLP: Service Location Protocol (SLP) is an Internet standard network
protocol that provides a framework to allow networking applications to
discover the existence, location, and configuration of networked services in
enterprise networks. This protocol simplifies discovery and use of network
resources such as printers, web servers, fax machines, video cameras, files
systems, backup devices (tape drives), databases, directories, mail servers,
calendars.
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Clear jams

Occasionally, media becomes jammed during a job.

Clear paper jams
Paper jams can occur either inside the printer or in the automatic document feeder.

Microsoft Web Services: Enable or disable the Microsoft Web Services
Dynamic Discovery (WS Discovery) protocols or Microsoft Web Services for
Devices (WSD) Print services supported on the printer. Disable unused print
services to prevent access through those services.

Bf NOTE: For more information about WS Discovery and WSD Print, visit
www.microsoft.com.

SNMP: SNMP (Simple Network Management Protocol) is used by network
management applications for device management. The printer supports
SNMPv1 protocol on IP networks.

WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server
on your network, the printer automatically obtains its IP address from that
server and registers its name with any RFC 1001 and 1002-compliant
dynamic name services as long as a WINS server IP address has been
specified.

Connected PC(s): Lists the computers connected to this printer, as well as the
last time these computers accessed the printer.

To print the network configuration page from the printer control panel

From the Home screen, touch J (right arrow), and then select Setup. Touch Reports,
and then select Network Configuration Page.

This section contains the following topics:

Clear paper jams
Avoid paper jams

/A CAUTION: To prevent possible damage to the printhead, clear paper jams as
soon as possible.

- TIP: If you notice poor print quality, clean the printhead. For more information, see
" Clean the printhead.

Use these steps to clear a paper jam.
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To clear a jam inside the printer
1.  Remove all media from the output tray.

/A CAUTION: Trying to clear a paper jam from the front of the printer can
damage the print mechanism. Always access and clear paper jams through
the automatic two-sided printing accessory (duplexer).

2.  Check the duplexer.
a. Push the button on either side of the duplexer, and then remove the unit.

b. Locate any jammed media inside the printer, grasp it with both hands and
then pull it towards you.

c. Ifthe jam is not there, push the latch on top of the duplexer and lower the
cover. If media is jammed inside, carefully remove it. Close the cover.

d. Reinsert the duplexer into the printer.
3.  Open the top cover and remove any debris.

4. If you have not found the jam and have Tray 2 installed, pull out the tray and
remove the jammed media, if possible. If not, do the following:

a. Ensure the printer is turned off and disconnect the power cord.

b Lift the printer off Tray 2.

c. Remove the jammed media from the bottom of the printer or from Tray 2.
d Reposition the printer on top of Tray 2.
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Open the ink cartridge access door. If there is paper remaining inside the printer,
ensure the carriage has moved to the right of the printer, free any paper scraps or
wrinkled media, and pull the media towards you through the top of the printer.

/A WARNING! Do not reach into the printer when it is on and the carriage is
stuck. When you open the ink cartridge access door, the carriage should
return to its position on the right side of the printer. If it does not move to the
right, turn off the printer before you remove any jam.

After clearing the jam, close all covers, turn on the printer (if you turned it off) and
resend the print job.

Avoid paper jams
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To help avoid paper jams, follow these guidelines.

Remove printed papers from the output tray frequently.

Make sure that you are printing with media that is not wrinkled, folded, or
damaged.

Prevent curled or wrinkled paper by storing all unused paper flat in a resealable
bag.

Do not use paper that is too thick or too thin for the printer.

Make sure that the trays are loaded correctly and are not too full. For more
information, see Load paper.

Ensure that paper loaded in the input tray lays flat and the edges are not bent or
torn.

Do not place too much paper in the document feeder tray. For information on the
maximum number of sheets allowed in the automatic document feeder, see
Paper specifications.

Do not combine different paper types and paper sizes in the input tray; the entire
stack of paper in the input tray must be the same size and type.

Adjust the paper-width guide in the input tray to fit snugly against all paper. Make
sure the paper-width guide does not bend the paper in the input tray.

Do not force paper too far forward in the input tray.

Use paper types that are recommended for the printer. For more information, see
Paper specifications.

If the printer is about to run out of paper, allow the printer to run out of paper first
and then add paper. Do not try to add paper while the printer is trying to pick up a
sheet.

If you are printing on both sides of a page, do not print highly saturated images
on light weight paper.

Make sure that the printer is clean. For more information, see Maintain the
printer.
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A Technical information

This section contains the following topics:

. Warranty information

. Printer specifications

. Regulatory information

. Environmental product stewardship program

. Third-party licenses

Warranty information
This section contains the following topics:
. Hewlett-Packard limited warranty statement

. Ink cartridge warranty information
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Hewlett-Packard limited warranty statement

HP product Duration of imited warranty

Saftware Medla 90 days

Printer 1 year

Print ar Ink cariridges Untll the HPF Ink |5 depleted or the “end of wamanty™ date

prinizd on ihe cartidge has been reached, whichevar ooours
first. This warranty does nat cowver HP Ink progucss that have
been refllied, remanufaciured, refurbished, misused, or

tamperad wiih.
Printheads (only applies to progucss with customer | 1 year
replaceable printheads)
ACCEESOTIES 1 year unless othenwise statad

A Extent of limitad

i

2
3

£
E.
7.

EB.

o

Hewsdett-Packard (HF} warranis ta the end-user customer that the HP products specified abave will be free from
defects In materials and workmanship for the duration specified abowve, which duralion beging on the dake of
purchase by the cusiomer.

Far software products, HP's imied warmanty appiles only ta a fallure io execule programming Instructions. HP
does not warrant that the operation of any product will b= Intermupted or emar free.

HF's limiied wamanty covers anly those defects that arkse as a result of nomal use of the product, and does not
cover any ofher probiems., Including thase that arse as a result of:

a. Improper malnienance or modfication;

b. Software, medla, parts, or supplles nat prowided or supparted by HP;

. Operafion cutside the products specticatians;

d. Unawthorzed modiication or miswss.

Far HP printer products, the use of a non-HP caririkdge ar a refilled carindge does nol afect efther the wamanty
ta the customer or any HP support contract with the cusiomer. However, I printer tallure or damage Is
atiributabie to the use of a nan-HP or refiled cartidge or an expired ink cariridge, HP will charge Its standard
time and materials charges to service the printer for the particular fallure or damage.

If HP receives, durng the applicable warranty period, notice of 3 defect in any prodwet which 15 covered by HP's
wamanty, HP shall ekher repalr or replace the product, at HP's aption.

If HF |5 uniabile to repalr or replace, as applicable, & defective product which Is covered by HP's warmanty, HP
shall, within a reasonable Gme after belng notified of the defect, refund the purchase price for the product.

HP shall have na obligation to repalr, replace, or refund wntl the customer retums the defective product o HR
Any replacement product may be efther new ar like-new, provided that | has funcionalty af least equal 1o that of
the product belng replaced.

HP products may contaln remanwtactured parts, components, or materals equivalent i new In

10. HP'e Limiked Wamanty Sfatement is valld In amy couniry where the coversd HP product ks dstibutad by HP.

Contracts for additional warranty sersices, such as on-slte senvdce, may be avalable from any authorzed HP
sendice facliity In countrizs where the product Is distributed by HP or by an authorized Imponer.

B. Limiathons of

T THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR T3 THIRD PARTY SUPPLIERS MAKES
ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES
OR COMDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNEZS FOR A PARTICULAR
PURPOSE.

C. Limiations of llabllty

1.
2

To the extent allowed by local law, the remedies pravided In this Warmanty Statemsent are the customer's sale
and excluslve remedles.

TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH
N THIS WARRANTY STATEMENT, IN MO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE
FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON
CONTRACT, TORT, OR ANY OTHER LEGAL THECRY AND WHETHER ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

D. Local law

1.

2

Thils Warranty Statement gives the customer speciic legal rights. The customer may alsa hiave other rights
whilkch wary from state io state in the United States, from province fo prowince n Canada, and from coundry ta
elsewhere In the world.

To the exient that this Warranty Statement Is Inconsistent with local law, this Warmranty Statement shall be

deemed modiied to be conslstent wih such local law. Under such kocal aw, ceraln dsclaimers and Iimitations

of this Warranty Statement may not apply to the customer. For example, some staies In the Unied States, as

well 35 some govermnments outside the Uniied States (including provinces In Canada), may:

a. Preciude the disciaimers and limitations in this Warranty Statemeant from Bmiting the statutory rights of a
consumer (e.q. the United Kingdam

b. Otherwlse restrict the abllity of a manufacturer to enfarce such disclaimers or lmitatons; or

c. Grant the customer addiional wamanty righis, specty the duration of Implied warranties which the
manutachurer cannot disclalm, or allow Imitations on the duration of Impilled wamantiae.

THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DD

NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY

RIGHTS APPLICABLE TO THE SALE OF THE HF PRODUCTS TO SUCH CUSTOMERS.

HP Limitad Warranty
The name and address of the HP enliy responsibie for the parformanics of the HP Limited Warranty In your country ks as
Tollowws:
Unithed Hewlelr-FPackard Lid Cain Road Bracknel G5-Bemks RG12 1HN

Kingcam:
Elre: Hewalt-Packard Iretand Limited, £3-74 Sir Jehn Rogerson's Quay, Cublin 2
Malta: Hewlet-Fackand Intemational Trage B.V. Malta Eranch, 48, Amery Street, Sliema SLM 1701, MALTA

Yau may have admbonal stautory rights against the saller based on your purchase agreement. Those rights are nat in any
way afecied by tis HP Limited \Wamanty.

Technical information



Ink cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printer.
This warranty does not cover HP ink products that have been refilled, remanufactured,
refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the
end of warranty date has not been reached. The end of warranty date, in YYYY-MM format, may
be found on the product as indicated:
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Printer specifications
This section contains the following topics:

. Physical specifications

. Product features and capacities

. Processor and memory specifications
. System requirements

. Network protocol specifications

. Embedded web server specifications

. Paper specifications
. Print specifications

. Web Services specifications

. HP website specifications

. Environmental specifications

. Electrical specifications

. Acoustic emission specifications
. Memory device specifications

Physical specifications
Printer size (width x height x depth)
. 494 x 238 x 460 mm (19.5 x 9.4 x 18.1 inches)
. With Tray 2: Adds 82 mm (3.2 inches) to the height of the printer
Printer weight
The printer weight does not include printing supplies or Tray 2.
. 8.58 kg (17.9 Ib)
. With Tray 2: Adds 2.8 kg (6.2 Ib)

Product features and capacities

Feature Capacity

Connectivity . USB 2.0-compliant high speed
. USB 3.0-compliant high speed
. USB 2.0 high-speed host port
. Wireless 802.11b/g/n*

. 802.3 network (Ethernet)

Print method Drop-on-demand thermal inkjet printing

Ink cartridges Four ink cartridges (one each for black, cyan,
magenta, and yellow)

NOTE: Not all ink cartridges are supported in
all countries/regions.

Printheads One printhead

Supply yields For more information on estimated ink
cartridge yields, visit www.hp.com/go/
learnaboutsupplies/.

Printer languages HP PCL 5, HP PCL 6, PS3, and PDF 5.
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(continued)

Feature Capacity

Font support US fonts: CG Times, CG Times ltalic,
Universe, Universe ltalic, Courier, Courier
Italic, Letter Gothic, Letter Gothic Italic.

Duty cycle Up to 25,000 pages per month

Printer control panel language support Arabic, Bulgarian, Croatian, Czech, Danish,
Dutch, English, Finnish, French, German,
Greek, Hebrew, Hungarian, Italian, Japanese,
Korean, Norwegian, Polish, Portuguese,
Romanian, Russian, Simplified Chinese,
Slovak, Slovenian, Spanish, Swedish,
Traditional Chinese, Turkish.

Language availability varies by country/region.

* The printer supports the 802.11n 2.4 GHz frequency band.

Processor and memory specifications

Printer processor
528 MHz processor dual core

Printer memory
512 MB built-in RAM, 128 MB Flash

System requirements
Software and system requirements are located in the Readme file.

r_lﬁ NOTE: For the most current information about supported operating systems and system
requirements, visit www.hp.com/support.

Network protocol specifications
Network protocol specifications are located in the Readme file.

r_lﬁ NOTE: For the most current information about supported operating systems and system
requirements, visit www.hp.com/support.

Embedded web server specifications

Requirements
. A TCP/IP-based network (IPX/SPX-based networks are not supported)

. A web browser (either Microsoft Internet Explorer 7.0 or higher, Mozilla Firefox 3.0 or
higher, Safari 3.0 or higher, or Google Chrome 5.0 or higher)

. A network connection (you cannot use the embedded web server connected directly to
a computer with a USB cable)

. An Internet connection (required for some features)

ﬁ_?’”{ NOTE: You can open the embedded web server without being connected to the
Internet. However, some features are not available.

NOTE: The embedded web server must be on the same side of a firewall as the
printer.
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Appendix A

Paper specifications

Use these tables to determine the correct media to use with your printer, and determine what
features work with your media.

. Understand specifications for supported paper
. Set minimum margins
. Guidelines for printing on both sides of a page

Understand specifications for supported paper

Use the tables to determine the correct media to use with your printer, and to determine what
features work with your media.

. Understand supported sizes

. Understand supported paper types and weights

Understand supported sizes

B NOTE: Tray 2 is available as an option.

Media size Tray 1 Tray 2 Duplexer

Standard media sizes

10x15cm

2L

U.S. Letter (216 x 279 mm; 8.5 x 11
inches)*

8.5 x 13 inches (216 x 330 mm)

U.S. Legal (216 x 356 mm; 8.5 x 14
inches)

<

A4 (210 x 297 mm; 8.3 x 11.7
inches)*

<
<

U.S. Executive (184 x 267 mm; 7.25
x 10.5 inches)

U.S. Statement (140 x 216 mm; 5.5
x 8.5 inches)

B5 (JIS) (182 x 257 mm; 7.17
x 10.12 inches)

A5 (148 x 210 mm; 5.8 x 8.3
inches)*

6 x 8 inches

Edge-to-Edge A4*

ANANANIAN AN NN NN AN ENAYAN
<

AR

Edge-to-Edge Letter*

Envelopes

U.S. #10 Envelope (105 x 241 mm;
4.12 x 9.5 inches)

A\
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(continued)

Media size Tray 1 Tray 2 Duplexer
Monarch Envelope (98 x 191 mm; V’
3.88 x 7.5 inches)

Card Envelope (111 x 152 mm; 4.4 ‘/
X 6 inches)

A2 Envelope (111 x 146 mm; 4.37 ‘/
x 5.75 inches)

DL Envelope (110 x 220 mm; 4.3 V’
x 8.7 inches)

C5 Envelope (162 x 229 mm; 6.4 x 9 | 4/
inches)

C6 Envelope (114 x 162 mm; 4.5 ‘/
X 6.4 inches)

Japanese Envelope Chou #3 (120 V’
x 235 mm; 4.7 x 9.3 inches)

Japanese Envelope Chou #4 (90 V’
x 205 mm; 3.5 x 8.1 inches)

Cards

Index card (76.2 x 127 mm; 3 x 5 V’
inches)

Index card (102 x 152 mm; 4 x 6 V’
inches)

Index card (127 x 203 mm; 5 x 8 ‘/
inches)

A6 card (105 x 148.5 mm; 4.13 ‘/
x 5.83 inches)

A4 index card (210 x 297 mm; 8.3 V’
x 11.7 inches)

Hagaki (100 x 148 mm; 3.9 x 5.8 V’
inches) **

Ofuku Hagaki** (200 x 148 mm; 7.8 | 4/
x 5.8 inches)

Index Card Letter (216 x 279 mm; ‘/
8.5 x 11 inches)

Photo media

Photo media (76.2 x 127 mm; 3 x5 ‘/
inches)

Photo media (102 x 152 mm; 4 x 6 V’
inches)

Photo media (5 x 7 inches) v
Photo media (8 x 10 inches) v
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Media size Tray 1 Tray 2

Duplexer

Photo media (8.5 x 11 inches)

Photo L (89 x 127 mm; 3.5x 5
inches)

Photo 2L (127 x 178 mm)

13x18 cm

AN AN IR

Other media

NOTE: Defining custom-size paper
sizes is only available in the HP
printing software in Mac OS X.

Custom-size paper between 76.2 to
216 mm wide and 127 to 356 mm
long (3 to 8.5 inches wide and 5 to
14 inches long)

<

* These sizes can be used for edge-to-edge printing.

** The printer is compatible with plain and inkjet hagaki from Japan Post only. It is not compatible

with photo hagaki from Japan Post.

Understand supported paper types and weights

Tray Type Weight

Capacity

Tray 1 Paper 60 to 105 g/m?
(16 to 28 Ib bond)

Up to 250 sheets of
plain paper

(25 mm or 1 inch

stacked)
Photo media 280 g/m? Up to 100 sheets
(75 Ib bond) (17 mm or 0.67 inch
stacked)
Envelopes 75 to 90 g/m? Up to 30 sheets
(20 to 24 Ib bond (17 mm or 0.67 inch
envelope) stacked)
Cards Up to 200 g/m? Up to 80 cards
(110 Ib index)
Tray 2 Plain paper only 60 to 105 g/m? Up to 250
(16 t0 28 Ibbond) ~ Sheets of
plain
paper
(25 mm
or1.0
inch
stacked)
Duplexer | Plain and brochure 60 to 105 g/m? Not applicable

(16 to 28 Ib bond)
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(continued)

Tray Type Weight Capacity

Output All supported media Up to 150 sheets of

tray plain paper (text
printing)

Set minimum margins
The document margins must match (or exceed) these margin settings in portrait orientation.

-

4
4|
\

_to ¥
A
le »le »lle m:*o

O © o 2

Media (1) Left (2) Right (3) Top (4) Bottom
margin margin margin margin

U.S. Letter 4 mm (0.16 4 mm (0.16 4 mm (0.16 4 mm (0.16
inch) inch) inch) inch)

U.S. Legal Windows and

A4 12mm (0.47

U.S. Executive inch) Mac

and Linux

U.S. Statement

8.5x 13 inch

B5

A5

Cards

Custom-size paper

Photo paper

Envelopes 4 mm (0.16 4 mm (0.16 16.5 mm 16.5 mm
inch) inch) (0.65 inch) (0.65 inch)

Guidelines for printing on both sides of a page

. Always use media that conforms to the printer specifications. For more information, see
Paper specifications.

. Specify two-sided printing options in your application or in the printer driver.

. Do not print on both sides of envelopes, photo paper, glossy media, or paper lighter than 16
Ib bond (60 g/m?) or heavier than 28 Ib bond (105 g/m?). Jams might occur with these media
types.
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. Several kinds of media require a specific orientation when you print on both sides of a page.
These include letterhead, preprinted paper, and paper with watermarks and prepunched
holes. When you print from a computer running Windows, the printer prints the first side of
the media first. Load the media with the print side facing down.

. For auto-duplexing, when printing finishes on one side of the media, the printer holds the
media and pauses while the ink dries. Once the ink dries, the media is pulled back into the
printer and the second side is printed. When printing is complete, the media is dropped onto
the output tray. Do not grab it before printing is complete.

Print specifications

Black print resolution
1200 x 1200 optimzed dpi on plain paper from 600 x 600 dpi input

Color print resolution
Up to 1200 x 1200 optimized dpi from 600 x 600 input dpi

Web Services specifications

HP

An Internet connection using either a wired (Ethernet) or wireless connection.

HP ePrint
. Maximum size of email and attachments: 5 MB
. Maximum number of attachments: 10

’Lﬁ/r NOTE: The printer's email address must be the only address listed in the “To” line of the
email message.

Supported file types:

° PDF

° HTML

° Standard text file formats

° Microsoft Word, PowerPoint

° Image files, such as PNG, JPEG, TIFF, GIF, BMP

@ NOTE: You might be able to use other types of files with HP ePrint. However, HP cannot
guarantee that they correct functionality with the printer because they have not been fully
tested.

Printer Apps

To use certain Printer Apps, you might need to set up an account with a partner website. For more
information, visit www.hpconnected.com.

website specifications

. A web browser (either Microsoft Internet Explorer 6.0 or higher, Mozilla Firefox 2.0 or
higher, Safari 3.2.3 or higher, or Google Chrome 3.0) with the Adobe Flash plug-in (version
10 or higher).

. An Internet connection

Environmental specifications

Operating environment

Operating temperature: 5° to 40° C (41° to 104° F)

Operating humidity: 15 to 80% RH non-condensing
Recommended operating conditions: 15° to 32° C (59° to 90° F)
Recommended relative humidity: 25 to 75% RH non-condensing
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Shipping environment
Maximum shipping temperature: -40° to 60° C (-40° to 140° F)
Maximum shipping humidity: 5 to 90% RH non-condensing

Electrical specifications

Power supply
Universal power adapter (internal)

Power requirements
Input voltage: 100 to 240 VAC, 50/60 Hz
Output voltage: +32V/+12V at 1095 mA/170 mA

Power consumption
34 watts printing (Fast Draft Mode)

Acoustic emission specifications
Print in Draft mode, noise levels per ISO 7779

HP Officejet Pro 251dw

. Sound pressure (bystander position)
LpAm 60 (dBA) (mono Draft print)
. Sound power

LwAd 6.7 (BA)

Memory device specifications
This section contains the following topics:
. Memory card specifications
. USB flash drives

Memory card specifications

Specifications

. Maximum recommended number of files on a memory card: 2,000

. Maximum recommended individual file size: 12 megapixel maximum, 10 MB maximum
(TIFF files, 50 MB maximum)

. Maximum recommended memory card size: 64 GB (solid state only)

ﬁﬁ’ NOTE: Approaching any of the recommended maximums on a memory card might
cause the performance of the printer to be slower than expected.

Supported memory card types

. Secure Digital (SD), Mini SD, Micro SD, SDXC

. High Capacity Secure Digital

. MultiMediaCard (MMC), MMC Plus, MMC (RS-MMC)

USB flash drives

HP has fully tested the following USB flash drives with the printer:

. Kingston: Data Traveler 100 USB 2.0 flash drive (4 GB, 8 GB, and 16 GB)
. Lexar JumpDrive Traveller: 1 GB

. Imation: 1 GB USB Swivel

. SanDisk: Cruzer Titanium plus USB Flash Drive 4 GB PN

. HP: 8 GB HI.SPEED USB flash drive v100w

Printer specifications
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@ NOTE: You might be able to use other USB flash drives with the printer. However, HP
cannot guarantee that they correct functionality with the printer because they have not been
fully tested.
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Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:

FCC statement

Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan
Notice to users in Japan about the power cord

Noise emission statement for Germany

European Union Regulatory Notice

GS Declaration (Germany)

Regulatory information for wireless products
Regulatory model number

FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified
that the following nofice be brought to the atlention of users of this product,

This equipment has been tested and found to comply with the limits for o Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed lo provide recson-
oble profection against harmiul interference in o residential installation.  This equipment
generales, uses and can radiole radio requency energy and, if net installed and vsed in
accordance with the instructions, may couse harmiul inferference o radio communications.
However, there is no guorgnbes that interference will not occur ina p-:;triicuh:r installation,
If this equipment does couse hormbul interference to rodio or television reception, which con
be determined by tuming the equipment off and on, the user is encouraged o try fo corredt
the interference by one ar more of the following measures:

Reorient the receiving anfenna,

Increase the separation between the equipment and the recaiver.

Connect the equipment info an oullet on o drcuit different from that te which the
receiver is conneched.

Consult the dealer or an experienced radio/TV technician for help.

For turther information, contoct:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanower Sireet
Pale Allo, Ca 94304
(650) 8571501

Modifications (pant 15,21)

The FCC requires the user to be nolified that any changes or modifications made to this
device that are not expre-s5|'f upprwed by HF may vaid the user's mﬂlmrity io operale the
equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
twa conditions: (1) this device may net cause harmbul interference, ond (2] this device must
accept any inferference received, including interference that may couse undesired

operation.

Regulatory information
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Notice to users in Korea

B2 77| 0l 7/7|& FHHE(BI )2 HALHEERE
3 F1712M 7 2 7HolM ABSE 2§ RAoZ 8o
OPH8 EBUTIZY | Lo ot A b o 9ia i ¥

VCCI (Class B) compliance statement for users in Japan

CoEME, MR TR WSS (Voo ) OERECRETC ST
PNEENRETY. COREE, RERMTRETECEEERELTVETS, o
ﬂ!##’?i‘ﬁ'*:‘rhﬁiﬁ I-BEACEFRLTENE AL FEARECECT
CEFBYET,

EHEVEAFCE > TELVEYVEVELTTEW.

Notice to users in Japan about the power cord

Heilk. AEZALBT 11— FESEVTZT L.
Az nr-EETO—- Kl A0RATEEHHESHA.

Noise emission statement for Germany

Geriiuschemission
Lpa = 70 dB am Arbeisplatz im Momalbedrizz nach DM 454635 T. 19

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU Directives:

. Low Voltage Directive 2006/95/EC

. EMC Directive 2004/108/EC

. Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid if powered with the correct CE-marked AC adapter provided
by HP.

If this product has wired and/or wireless telecommunications functionality, it also complies with the
essential requirements of the following EU Directive:

R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European
standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for
this product or product family and available (in English only) either within the product
documentation or at the following web site: www.hp.com/go/certificates (type the product number
in the search field).
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The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications
products and for EU harmonized

telecommunications products, such
as Bluetooth® within power class
below 10mW.

For EU non-harmonized
telecommunications products (If
applicable, a 4-digit notified body

number is inserted between CE
and!).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland,
France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania,
Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia,
Spain, Sweden, Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue
telephone networks.

Products with wireless LAN devices

Some countries may have specific obligations or special requirements about the operation of
Wireless LAN networks such as indoor use only or restrictions of the channels available. Please
make sure that the country settings of the wireless network are correct.

France

For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may
be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For
outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For
the latest requirements, see www.arcep.fr.

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY

GS Declaration (Germany)

GS-Erklarung (Deutschland)

Das Gardt ist nicht fiir die Benulzung im unmittedbaren Gesichisfeld am Bildschirmarbeitsplatz
vergesehen. Um stirende Reflexionen am Bildschirmarbeitsplalz zu vermeiden, dod dieses Produkd
nicht im unmittelbaren Gesichisfeld plotziert werden,
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Regulatory information for wireless products
This section contains the following regulatory information pertaining to wireless products:

. Exposure to radio frequency radiation
. Notice to users in Brazil

. Notice to users in Canada

. Notice to users in Taiwan

. Notice to users in Mexico

. Notice to users in Japan

Exposure to radio frequency radiation

Exposure to radio frequency radiation

Frequenc',,r exXposue limits. Mevertheless, the device shall be used in such a manner
that the potential for humen contact dering normal operalion is minimized. This
praduct and any atoched external antenna, if supported. shall be ploced in such
a manner bo minimize fhe potential for human contact during normal operation, In
order fo avoid the possibility of exceeding the FCC rodio frequency expeosure
limits, human proximity o the antenna shall not be less than 20 cm (8 inches)
during normal operation,

i Caution The rodioted output power of this device is far below the FOC radio

Notice to users in Brazil

Aviso aos usudrios no Brasil

Este equipamenio opera em cardler secunddrio, islo &, ndo lem direilo & prolecdo conlra inter
feréncio prejudicial, mesmo de estoges do mesme lipe, ¢ ndo pode cowar interleréncia o
sistemas operando em cardler primério, [Res ANATEL 282,/2001).
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Notice to users in Canada

Notice to users in Canada/Note a l'attention des ufilisateurs canadiens

Under Industry Canada regulations, this radio transmitter may only operate using an
anlenna of a ype and maximum [or lessar) gain appreved for the transmilier by Industry
Canada. To reduce polential radio inferference to ofher users, the antenna type and its gain
should be so chosen that the equivalent isolropically radiated power [e.i.rp.) is not more
than that necessary for successful communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation iz
subject to the following two conditions: (1) this device may not cavse interference, and (2)
this device must accept any inlerference, including inferference that may cause undesired
operation of the device.

WARMNIMG! Exposure to Rodio Frequency Radiation The radialed culput power of this
device is below the Industry Canada radic frequency exposure limits. Mevertheless, the
device should be used in such o manner that the potential for human contact is minimized
during normal eperatien,

To avoid the possibility of exceeding the Industry Canada radic frequency exposure limits,
human proximity to the antennas should not be less than 20 em (8 inches).

Conformément au Réglement d'Industie Canadao, cet émetteur radicélecirique ne peul
fonctionner qu'avec une antenne d'un type et d'un gain maximum {ov moindre) approwve
par Indushrie Canada. Afin de réduire le brovillage radicélectrique potentiel pour d'autres
utilisateurs, le type d'anlenne e son gain doivent ére choisis de manidére & ce que la
puissance isolrope rayonnée équivalente [p.i.re.) ne dépasse pos celle nécessaire & une
communication réussie.

Cet appareil est conforme aux nomes RS5 exemples de licence d'Industie Canada, Son
fenctionnement dépend des deux conditions suivantes : (1) cel apparsil ne doil pas
provoquer d'interférences nuisibles et (2] deil occepler toutes interférences recues, y

AVERTISSEMEMT relatif & I'expesition aux radiclréquences. Lo puissance de rayonnemeni
de cet appareil se trouve sous les limites d'exposition de rodicfréquences d'lndustrie
Canada. Méanmoins, cet appareil deit étre utilisé de telle sorte qu'il soit mis en conlect le
moins possible avec le corps humain.

Afin d'éviter le dépassement éventuel des limites d'exposition oux radicfréquences
d'Industrie Canada, il est recommandé de maintenir une distance de plus de 20 cm enire
les antennes et I'utilisateur.

compris des interférences pouvant provaquer un fonclionnement non souhaité de 'appareil.

Notice to users in Taiwan

EnREREHEEHETENE
gt

BRARRAR2EEHARE  FENT A 0F, BHHEAEFHTENaREN

%, MADERWERE 2% R IDRE,
Dok

EHEHAREEATAERANELETRAEEE  ERAATERLS MU

HER  tARESTESSSEANER.

MEESEER  BEREIAZERZRARER, EHEHARRATZSZEER

T, ASLERAREENMREBENZTE.
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Notice to users in Mexico

Aviso para los usuarios de México

Lo operacién de este equipe esta sujela a las siguientes dos condiciones: (1) es posible
que este equipe o dispositive no cause inferderencia perjudicial v (2) este equipo o
dispmi‘.im debe acephar cualquier interferencia, inc uyendo lo que pueda cousar su
operacion no deseoda,

Para saber &l medelo de lo tarjeta inalambrica utilizoda, revise la etiqueta requlatoria de
la impresora

Notice to users in Japan

COFRFEREEES AL IFEHER R - RREREEE L TVET.

Regulatory model humber

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SNPRC-1203-01. This regulatory number should
not be confused with the marketing name (HP Officejet Pro 251dw Printer) or product number.

104 Technical information



Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sustainable

manner:

. Design for recycling has been incorporated into this product.

. The number of materials has been kept to a minimum while ensuring proper functionality
and reliability.

. Dissimilar materials have been designed to separate easily.

. Fasteners and other connections are easy to locate, access, and remove using common
tools.

. High priority parts have been designed to access quickly for efficient disassembly and
repair.

For more information, visit www.hp.com/ecosolutions.

This section contains the following topics:
. Paper use

. Plastics

. Material safety data sheets

. Recycling program

. HP inkjet supplies recycling program

. Disposal of waste equipment by users in private households in the European Union
. Power consumption

. Chemical Substances

. Battery information
. RoHS notices (China only)

. Restriction of hazardous substance (Ukraine)

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the
ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/
regions, and partners with some of the largest electronic recycling centers throughout the world.
HP conserves resources by reselling some of its most popular products. For more information
regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following Web site:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/
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Disposal of waste equipment by users in private households in the European Union
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Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is
qualified to the U.S. Environmental Protection Agency's ENERGY STAR specifications for
imaging equipment. The following mark appears on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:
www.hp.com/go/energystar

Chemical Substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Battery information
This section contains the following topics:
. Battery disposal in the Netherlands
. Battery disposal in Taiwan
. California Perchlorate Material Notice

Battery disposal in the Netherlands

ML) Batteri] niet = Dit HP Product bevat een lithium-manganese-diowide

—— waggooien, maar X batterij. Deze bevindt zich op de hoofdprintplaat. Wanneer

inleveran als KCA deze batterij leeg is, moet deze volgens de geldende regels
worden afgevoerd.

Battery disposal in Taiwan
C mmumau
UD Please recycle waste batteries.

California Perchlorate Material Notice

Califernia Perchlorate Material Notice

Perchlorate malerial - 5ped|::| hund|ing = upphr. Sea:
hitp:/ Fwwow.dise.ca.gov/hazardouswaste,/ perchlorate/

This products reaktime clock batiery or coin cell batery may contain perchlorate and
may require special handling when recycled or disposed of in Califomia.
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RoHS notices (China only)

Toxic and hazardous substance table
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Restriction of hazardous substance (Ukraine)

TexHiuHMi pernameHt Wono obMemeHH BHKOPHCTOHHA
uebarneunmnx peuosmu (Ypaiua)
OENORHOHHE BIANOSIR0E BHMoTaM TEXHINHOND PEIMOMEHTY WORD OOMEXEHHE BHKOPHCTOHHS

JAERKEHX H'E@I'H!HHMK PE"-ID'BHH B EﬂE'.'I'II:M'-IH‘}M."!I T E\.I'IEKTFIJH'HDM}T 'EﬂS.I'ICIHHUHH-Ir
IaTEEpAXEHcro noctawoscwo Kabinery Mikictpie Ypainw eig 3 rpyaqs 2008 MNe 1057
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Third-party licenses

LICENSE.aes-pubdom--crypto

/* rijndael-alg-fst.c

*

* @version 3.0 (December 2000)

*

* Optimised ANSI C code for the Rijndael cipher (now AES)

* @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>

* @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>
* @author Paulo Barreto <paulo.barreto@terra.com.br>

*

* This code is hereby placed in the public domain.

* THIS SOFTWARE IS PROVIDED BY THE AUTHORS "AS IS" AND ANY EXPRESS

* OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

* WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE

* LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

* BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
*WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE

* OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,

* EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

*/

LICENSE.expat-mit--expat

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LICENSE.hmac-sha2-bsd--nos_crypto

/* HMAC-SHA-224/256/384/512 implementation

* Last update: 06/15/2005

* Issue date: 06/15/2005

* Copyright (C) 2005 Olivier Gay (olivier.gay@a3.epfl.ch)

* All rights reserved.

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. Neither the name of the project nor the names of its contributors

* may be used to endorse or promote products derived from this software

* without specific prior written permission.

* THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS "“AS IS" AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE

* ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT

* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*/

LICENSE.open_ssl--open_ssl
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Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written
by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as
the following conditions are aheared to. The following conditions

apply to all code found in this distribution, be it the RC4, RSA,

Ihash, DES, etc., code; not just the SSL code. The SSL documentation
included with this distribution is covered by the same copyright terms
except that the holder is Tim Hudson (th@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in

the code are not to be removed.

If this package is used in a product, Eric Young should be given attribution
as the author of the parts of the library used.

This can be in the form of a textual message at program startup or

in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the copyright

notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright

notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software

must display the following acknowledgement:

"This product includes cryptographic software written by

Eric Young (eay@cryptsoft.com)"

The word 'cryptographic' can be left out if the rouines from the library

being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE

ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
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DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT

LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

The licence and distribution terms for any publically available version or
derivative of this code cannot be changed. i.e. this code cannot simply be
copied and put under another distribution licence

[including the GNU Public Licence.]

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in

the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without

prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"
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THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tih@cryptsoft.com).

Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in

the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without
prior written permission. For written permission, please contact

openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
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nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tih@cryptsoft.com).

Copyright 2002 Sun Microsystems, Inc. ALL RIGHTS RESERVED.
ECC cipher suite support in OpenSSL originally developed by
SUN MICROSYSTEMS, INC., and contributed to the OpenSSL project.

LICENSE.sha2-bsd--nos_crypto

/* FIPS 180-2 SHA-224/256/384/512 implementation

* Last update: 02/02/2007

* Issue date: 04/30/2005

* Copyright (C) 2005, 2007 Olivier Gay <olivier.gay@a3.epfl.ch>

* All rights reserved.

* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:

* 1. Redistributions of source code must retain the above copyright
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* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. Neither the name of the project nor the names of its contributors

* may be used to endorse or promote products derived from this software

* without specific prior written permission.

* THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS "AS IS" AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE

* ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL

* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS

* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT

* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

¥l

LICENSE.zlib--zlib
zlib.h -- interface of the 'zlib' general purpose compression library
version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software

in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.
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Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for
Comments) 1950 to 1952 in the files http://www.ietf.org/rfc/rfc1950.txt
(zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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B HP supplies and accessories

This section provides information on HP supplies and accessories for the printer. The information
is subject to changes, visit the HP website (www.hpshopping.com) for the latest updates. You
may also make purchases through the website.

|§/f’ NOTE: Not all cartridges are available in all countries/regions.

This section contains the following topics:

. Order printing supplies online
. Supplies

Order printing supplies online

To order supplies online or create a printable shopping list, open the HP software that came with
your printer and click Shop. Select Shop for Supplies Online. The HP software uploads, with
your permission, printer information, including model number, serial number, and estimated ink
levels. The HP supplies that work in your printer are pre-selected. You can change quantities, add
or remove items, and then print the list or purchase online at the HP Store or other online retailers
(options differ by country/region). Cartridge information and links to online shopping also appear
on ink alert messages.

You can also order online by visiting www.hp.com/buy/supplies. If prompted, select your country/
region, follow the prompts to select your printer, and then the supplies you need.

|§/f’ NOTE: Ordering cartridges online is not supported in all countries/regions. However, many
countries have information on ordering by telephone, locating a local store and printing
a shopping list. In addition, you can select the 'How to Buy' option at the top of the
www.hp.com/buy/supplies page to obtain information about purchasing HP products in your

country.
Supplies
. Ink cartridges and printheads
. HP paper

Ink cartridges and printheads

Ordering cartridges online is not supported in all countries/regions. However, many countries have
information on ordering by telephone, locating a local store and printing a shopping list. In
addition, you can select the 'How to Buy' option at the top of the www.hp.com/buy/supplies page
to obtain information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the ink cartridge you
are replacing. You can find the cartridge number in the following places:

. In the embedded web server, by clicking the Tools tab, and then, under Product
Information clicking Ink Gauge. For more information, see Embedded web server.

. On the printer status report (see Understand the Printer Status Report).

. On the label of the ink cartridge you are replacing.

On a sticker inside the printer.

/\ CAUTION: The Setup ink cartridge that comes with the printer is not available for
separate purchase. Check for the correct cartridge number through the EWS, on the
printer status report, or on the sticker inside the printer.
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@ NOTE: Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace cartridges until
prompted to do so.

HP paper
To order paper such as HP Premium Paper, go to www.hp.com.

HP recommends plain papers with the ColorLok logo for printing
and copying of everyday documents. All papers with the
ColorLok logo are independently tested to meet high standards
of reliability and print quality, and produce documents with crisp,
vivid color, bolder blacks, and that dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of
weights and sizes from major paper manufacturers.
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C Network setup

You can manage network settings for the printer through the printer control panel as described in
the next section. Additional advanced settings are available in the embedded web server,

a configuration and status tool you access from your web browser using an existing network
connection to the printer. For more information, see Embedded web server.

This section contains the following topics:

. Change basic network settings

. Change advanced network settings

. Set up the printer for wireless communication
. Uninstall and reinstall the HP software

Change basic network settings

The control panel options enable you to set up and manage a wireless connection and to perform
a variety of network management tasks. This includes viewing the network settings, restoring the
network defaults, turning the wireless radio on and off, and changing the network settings.

This section contains the following topics:
. View and print network settings

. Turn the wireless radio on and off

View and print network settings

You can display a summary of the network settings on the printer control panel or the HP software
that came with the printer. You can print a more detailed network configuration page, which lists
all of the important network settings such as the IP address, link speed, DNS, and mDNS. For
more information, see Understand the network configuration page.

Turn the wireless radio on and off

The wireless radio is on by default, as indicated by the blue light on the front of the printer. In
order to stay connected to a wireless network, the radio must stay on. However, if your printer is
connected to an Ethernet network or you have a USB connection, the radio is turned off.

1. Touch e (right arrow), touch Setup, and then touch Network.

2. Touch Wireless, and then touch On to turn on the radio, or touch Off to turn off the radio.
For information about connecting the printer to a wireless network, see Set up the printer for

wireless communication. If the Wireless Setup Wizard is used to connect the printer to a wireless
network the radio is automatically turned on.

Change advanced network settings

/\ CAUTION: Network settings are provided for your convenience. However, unless you are an
advanced user, you should not change some of these settings (such as the link speed, IP
settings, default gateway, and firewall settings).

This section contains the following topics:

. Set link speed

. View IP settings

. Change IP settings

. Configure the printer’s firewall settings
. Reset network settings
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Set link speed

You can change the speed at which data is transmitted over the network. The default is
Automatic.

1. Touch = (right arrow), touch Setup, and then touch Network.
2. Touch Advanced Setup, then touch Link Speed.
3. Touch the number next to the link speed that matches your network hardware.

View IP settings
To view the IP address of the printer:

. Print the network configuration page. For more information, see Understand the network
configuration page.
-Or-

. Open the HP software (Windows), double-click Estimated Ink Levels, click the Device

Information tab. The IP address is listed in the Network Information section.

Change IP settings
The default IP setting for the IP settings is Automatic, which sets the IP settings automatically.
However, if you are an advanced user, you might want to manually change settings such as the IP
address, subnet mask, or the default gateway.

/\ CAUTION: Be careful when manually assigning an IP address. If you enter an invalid IP
address during the installation, your network components cannot connect with the printer.

1. Touch e (right arrow), Setup, and then touch Network.
2. Touch Advanced Setup, and then touch IP Settings.

3. A message appears warning that changing the IP address removes the printer from the
network. Touch OK to continue.

4. Automatic is selected by default. To change the settings manually, touch Manual, and then
enter the appropriate information for the following settings:

. IP Address
. Subnet Mask

. Default Gateway
. DNS Address
5. Enter your changes, and then touch Done.

Configure the printer’s firewall settings

Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall
provides simple control of IP addresses that are allowed access.

@ NOTE: In addition to firewall protection at the network layer, the printer also supports open
secure sockets layer (SSL) standards at the transport layer for secure client-server
applications, such as client-server authentication or HTTPS web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP
traffic. Firewall policy pages are accessed through the EWS and displayed by your web browser.

After a policy is configured, it is not activated until you click Apply in the EWS.

Creating and using firewall rules

Firewall rules allow you to control IP traffic. Use firewall rules to allow or drop IP traffic based on
IP addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for
those addresses and services.
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This section contains the following topics:

. Create a firewall rule

. Change the priority of firewall rules

. Change firewall options

. Reset firewall settings

. Limitations to rules, templates, and services

Create a firewall rule

To create a firewall rule, complete the following steps:

1. Open the embedded web server. For more information, see Embedded web server.
2. Click the Settings tab, click Firewall Rules.

3. Click New, and then follow the onscreen instructions.

r_lﬁ NOTE: After clicking OK, the connection to the EWS might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the EWS connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the EWS.

Change the priority of firewall rules

To change the priority in which a firewall rule is used, complete the following steps:

1. Open the embedded web server. For more information, see Embedded web server.
2. Click the Settings tab, click Firewall Rules Priority.

3. Select the priority in which you want the rule to be used from the Rule Precedence list, with
10 having the highest priority and 1 having the lowest priority.

4. Click Apply.

Change firewall options
To change firewall options for the printer, complete the following steps:
1. Open the embedded web server. For more information, see Embedded web server.

2. Click the Settings tab, click Firewall Options.
3. Change any settings, and then click Apply.

r_lﬁ NOTE: After clicking Apply, the connection to the EWS might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the EWS connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the EWS.

Reset firewall settings

To reset the firewall settings to the factory defaults, restore the printer’s network settings. For
more information, see Reset network settings.

Limitations to rules, templates, and services
When creating firewall rules, note the following limitations to rules, templates, and services.

Item Limit

Maximum number of rules. 11 (one default rule)
Maximum number of Address Templates. 12

Maximum number of user-defined address 5

templates.

Maximum number of services you can add to 40

a user-defined service template.
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(continued)

Item Limit

NOTE: The predefined All Services template
is not subject to this limitation and includes all
services supported by the print server.

Maximum number of services you can add to 40
the policy.

For a given rule, only one address template
and one service template can be added.

Maximum number of service templates in the 9
policy.

Maximum number of user-defined custom 5
service templates.

Reset network settings
To reset the administrator password and network settings, complete the following steps:

1.

On the printer control panel, touch e (right arrow), touch Setup, and then touch Network.

2. Touch Restore Network Defaults, and then select Yes.

A message appears stating that the network defaults have been restored.

’Lﬁ/r NOTE: Print the network configuration page and verify that the network settings have been

reset. For more information, see Understand the network configuration page.

NOTE: Resetting the printer's network settings also resets the printer’s firewall settings. For
more information about configuring the printer’s firewall settings, see Configure the printer’s

firewall settings.

Set up the printer for wireless communication
You can set up the printer for wireless communication.

This section contains the following topics:

Before you begin
Set up the printer on your wireless network

Change the connection type
Test the wireless connection

Guidelines for ensuring wireless network security

Guidelines for reducing interference on a wireless network

@ NOTE: If you encounter problems connecting the printer, see Solve wireless problems.

Q TIP: For more information about setting up and using the printer wirelessly, visit the HP

Wireless Printing Center (www.hp.com/go/wirelessprinting).

Before you begin
Before you begin setting up the wireless connection, check the following:

The printer is not connected to the network using a network cable.
The wireless network is set up and functioning correctly.
The printer and the computers that use the printer are on the same network (subnet).
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While connecting the printer, you might be prompted to enter the wireless network name (SSID)
and a wireless password:

. The wireless network name is the name of your wireless network.

. The wireless password prevents other people from connecting to your wireless network
without your permission. Depending on the level of security required, your wireless network
might use either a WEP key or WPA passphrase.

If you have not changed the network name or the security passkey since setting up your wireless

network, you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security passkey or cannot remember this information,
see the documentation available with your computer or with the wireless router. If you still cannot
find this information, contact your network administrator or the person who set up the wireless
network.

X0: TIP: If you are using a computer running Windows, HP provides a tool called HP Print and
" Scan Doctor that can help retrieve this information for some systems. To use this tool, visit the
HP Wireless Printing Center (www.hp.com/go/wirelessprinting). (At this time, this tool might
not be available in all languages.)

Set up the printer on your wireless network
To set up the printer on your wireless network, use one of the following methods:
. Set up the printer using the HP printer software
. Set up the printer using the Wireless Setup Wizard
. Set up the printer using WiFi Protected Setup (WPS)
. Set up the printer using the embedded web server (EWS)

|§/f’ NOTE: If you have already been using the printer with a different type of connection, such as
a USB connection, follow the instructions in Change the connection type to set up the printer
on your wireless network.

Set up the printer using the HP printer software

In addition to enabling key printer features, you can use the HP printer software that came with
your printer to set up wireless communication.

If you have already been using the printer with a different type of connection, such as a USB
connection, follow the instructions in Change the connection type to set up the printer on your
wireless network.

Set up the printer using the Wireless Setup Wizard

The Wireless Setup Wizard provides an easy way to set up and manage a wireless connection to
your printer from the printer control panel.

1. Set up the printer hardware. See the getting started guide or the setup poster that came
with your printer.

On the printer control panel, touch [ (right arrow), touch Setup, and then touch Network.
Touch Wireless Setup Wizard, and then touch OK.
Follow the display instructions to complete the setup.

After the setup has completed, the network printer drivers can be installed by opening the
printer's HP folder in All Programs, clicking Printer Setup and Software , and selecting
Connect a new printer.

o eDn

|§/f’ NOTE: If you cannot find the wireless network name (SSID) and wireless password (WPA
passphrase, WEP key), see Before you begin.
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Set up the printer using WiFi Protected Setup (WPS)

Wi-Fi Protected Setup (WPS) allows you to quickly set up the printer on your wireless network,
without having to enter the wireless network name (SSID), wireless password (WPA passphrase,
WEP key), or other wireless settings.

Br NOTE: Only set up wireless using WPS if your wireless network uses WPA data encryption.
If your wireless network uses WEP or is not using any encryption at all, use one of the other
methods provided in this section to set up the printer on your wireless network.

NOTE: To use WPS, make sure your wireless router or wireless access point supports

WPS. Routers that support WPS often have a @ (WPS) button or a button labeled "WPS".

You can use one of the following methods to set up the printer using WPS:

Push Button Method: Use the @ (WPS) or WPS button, if available, on your router.
. PIN Method: Enter the PIN generated by the printer in the router’s configuration software.

To connect the printer using the Push Button Method

1. On the printer control panel, touch e (right arrow), touch Setup, and then touch Network.
2 Touch Wi-Fi Protected Setup, and then follow the on-screen instructions.

3. When prompted, touch Push Button.
4

On the wireless router or wireless access point, press and hold the WPS button for 3
seconds.

Wait for about 2 minutes. If the printer connects successfully, the wireless light stops
blinking but remains lit.

5. After the setup has completed, the network printer drivers can be installed by opening the
printer's HP folder in All Programs, clicking Printer Setup and Software , and selecting
Connect a new printer.

To connect the printer using the PIN Method

1. On the printer control panel, touch [ (right arrow), touch Setup, and then touch Network.
A WPS PIN is printed at the bottom of the page.

2. Touch Wi-Fi Protected Setup, and then follow the on-screen instructions.

3. When prompted, touch PIN.
The WPS PIN appears on the display.

4. Open the configuration utility or software for the wireless router or wireless access point,
and then enter the WPS PIN.

ﬁz?r’ NOTE: For more information about using the configuration utility, see the
documentation provided with the router or wireless access point.

Wait for about 2 minutes. If the printer connects successfully, the wireless light stops
blinking but remains lit.

5. After the setup has completed, the network printer drivers can be installed by opening the
printer's HP folder in All Programs, clicking Printer Setup and Software , and selecting
Connect a new printer.

Set up the printer using the embedded web server (EWS)

If the printer is connected to a network, you can use the printer's embedded web server (EWS) to
set up wireless communication.

1. Open the EWS. For more information, see Embedded web server.
2. On the Home tab, click Wireless Setup Wizard in the Setup box.
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3. Follow the on-screen instructions.
4. After the setup has completed, the network printer drivers can be installed by opening the

printer's HP folder in All Programs, clicking Printer Setup and Software , and selecting
Connect a new printer.

Q TIP: You can also set up wireless communication by entering or changing individual wireless
settings. To change these settings, on the Network tab, click Advanced in the Wireless
(802.11) section on the left, change the wireless settings, and then click Apply.

Change the connection type

After you have installed the HP software and connected the printer to your computer or to a
network, you can use the HP software to change the connection type (for example, from a USB
connection to a wireless connection).

r_lﬁ NOTE: If you are changing to a wireless connection, make sure that an Ethernet cable has
not been connected to the printer. Connecting an Ethernet cable turns off the printer's
wireless capabilities.

You might be prompted to temporarily connect a USB cable during the setup process.

To change from an Ethernet connection to a wireless connection

1. On the printer control panel, touch [ (right arrow), touch Setup, and then touch Network.
2. Touch Wireless, touch Wireless Setup Wizard, and then touch OK.
3. Follow the display instructions to complete the setup.

ﬁﬁ’ NOTE: If you cannot find the wireless network name (SSID) and wireless password
(WPA passphrase, WEP key), see Before you begin.

To change from a USB connection to a wireless connection
Follow the instructions for your operating system.

Windows

1. On the computer desktop, click Start, select Programs or All Programs, click HP, click the
folder for your printer, and then click Printer Setup & Software.
-Or-

On the Start screen, click Printer Setup & Software.
2. Click Convert a USB connected printer to wireless.
3. Follow the display instructions to complete the setup.

Mac OS X

1. Open HP Utility. For more information, see HP_Utility (Mac OS X).

2. Click the Applications icon on the HP Ultility toolbar.

3. Double-click HP Setup Assistant, and then follow the on-screen instructions.

To change from a wireless connection to a USB or Ethernet connection

To change from a wireless connection to a USB or Ethernet connection, connect the USB or
Ethernet cable to the printer.

r_lﬁ NOTE: If you are using a computer with Mac OS X, add the printer to the print queue. Click
System Preferences in the Dock, click Print & Fax or Print & Scan in the Hardware section,
click +, and then select the printer.

Test the wireless connection

Print the wireless test page for information about the printer's wireless connection. The wireless
test page provides information about the printer's status, hardware (MAC) address, and IP
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address. If the printer is connected to a network, the test page displays details about the network
settings.

To print the wireless test page

1. On the printer control panel, touch & (right arrow), touch Setup, and then touch Network.
2. Touch Wireless, and then touch Print Wireless Network Test.

Guidelines for ensuring wireless network security

The following information can help you keep your wireless network and wireless printer secure
from unauthorized use.

For more information, visit www.hp.com/go/wirelessprinting.

This section contains the following topics:

. Overview of security settings
. Add hardware addresses to a wireless router (MAC filtering)
. Other wireless security guidelines

Overview of security settings

To help improve the security of the wireless network and prevent unauthorized access, the printer

supports many common types of network authentication, including WEP, WPA, and WPA2.

. WEP: Provides security by encrypting data sent over radio waves from one wireless device
to another wireless device. Devices on a WEP-enabled network use WEP keys to encode
data. If your network uses WEP, you must know the WEP key(s) it uses.

. WPA: Increases the level of over-the-air data protection and access control on existing and
future wireless networks. It addresses all known weaknesses of WEP, the original native
security mechanism in the 802.11 standard. WPA uses the Temporal Key Integrity Protocol
(TKIP) for encryption and employs 802.1X authentication with one of the standard
Extensible Authentication Protocol (EAP) types available today.

. WPAZ2: Provides enterprise and consumer wireless users with a high level of assurance that
only authorized users can access their wireless networks. WPA2 provides the Advanced
Encryption Standard (AES). AES is defined in counter cipher-block chaining mode (CCM)
and supports the Independent Basic Service Set (IBSS) to enable security between client
workstations operating connected wirelessly without a wireless router (such as a Linksys
wireless router or Apple AirPort Base Station).

Add hardware addresses to a wireless router (MAC filtering)

MAC filtering is a security feature in which a wireless router or wireless access point is configured
with a list of hardware addresses (also called "MAC addresses") of devices that are allowed to
gain access to the network through the router.

If the router filters hardware addresses, then the printer's hardware address must be added to the
router’s list of accepted hardware addresses. If the router does not have the hardware address of
a printer attempting to access the network, the router denies the printer access to the network.

/\ CAUTION: This method is not recommended, however, because your MAC addresses can
easily be read and falsified by unwanted users outside your network.

To add hardware addresses to a wireless router or wireless access point

1. Print the network configuration page, and then locate the printer's hardware address. For
more information, see Understand the network configuration page.

|”§/f’ NOTE: The printer maintains separate hardware addresses for the Ethernet
connection and for wireless connection. Both hardware addresses are listed on the
printer’'s network configuration page.

2. Open the configuration utility for the wireless router or wireless access point, and add the
printer's hardware address to the list of accepted hardware addresses.
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|§/f’ NOTE: For more information about using the configuration utility, see the documentation

provided with the router or wireless access point.

Other wireless security guidelines
To keep the wireless network secure, follow these guidelines:

Use a wireless password with at least 20 random characters. You can use up to 64
characters in a WPA wireless password.

Avoid any common words or phrases, easy sequences of characters (such as all 1s), and
personally-identifiable information for wireless passwords. Always use random strings
composed of uppercase and lowercase letters, numbers, and if allowed, special characters
such as punctuation.

Change the default wireless password provided by the manufacturer for administrator
access to the access point or wireless router. Some routers let you change the
administrator name as well.

Turn off administrative access over wireless if possible. If you do this, you need to connect
to the router with an Ethernet connection when you want to make configuration changes.
Turn off remote administrative access over the Internet on your router, if possible. You can
use Remote Desktop to make an encrypted connection to a computer running behind your
router and make configuration changes from the local computer you are accessing over the
Internet.

To avoid accidentally connecting to another party's wireless network, turn off the setting to
automatically connect to non-preferred networks. This is disabled by default in Windows
XP.

Guidelines for reducing interference on a wireless network
The following tips will help reduce the chances for interference in a wireless network:

Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones, as these objects
can disrupt radio signals.

Keep the wireless devices away from large masonry structures and other building structures
as these objects can absorb radio waves and lower signal strength.

Position the access point or wireless router in a central location in line of sight with the
wireless devices on the network.

Keep all wireless devices on the network within range of one another.

Uninstall and reinstall the HP software

If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the HP software installation screen, you might need to uninstall and then reinstall the
HP software that came with the printer. Do not simply delete the printer application files from your
computer. Make sure to remove them correctly using the uninstall utility provided when you
installed the HP software.

. Windows
. Mac OS X
Windows

To uninstall — method 1

1. Disconnect the printer from your computer. Do not connect it to your computer until after
you have reinstalled the HP software.

2. On the computer desktop, click Start, select Programs or All Programs, click HP, click the
printer name, and then click Uninstall.

3. Follow the on-screen instructions.
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If you are asked whether you would like to remove shared files, click No.
Other programs that use these files might not work correctly if the files are deleted.
Restart your computer.

To reinstall the HP software, insert the HP software CD into your computer's CD drive, and
follow the on-screen instructions.

Connect the printer when the HP software prompts you to connect it to the computer.

Press the l_I_J (Power button) to turn the printer on.
After connecting and turning on the printer, you might have to wait several minutes for all of
the Plug and Play events to complete.

Follow the on-screen instructions.

To uninstall — method 2

@ NOTE: Use this method if Uninstall is not available in the Windows Start menu.

1. On the computer desktop, click Start, select Settings, click Control Panel, and then click
Add/Remove Programs.
-Or-
Click Start, click Control Panel, and then double-click Programs and Features.
2. Select the printer name, and then click Change/Remove or Uninstall/Change.
Follow the on-screen instructions.
3. Disconnect the printer from your computer.
4. Restart your computer.
@/]’ NOTE: It is important that you disconnect the printer before restarting your computer.
Do not connect the printer to your computer until after you have reinstalled the HP
software.
5. Insert the HP software CD into your computer's CD drive and then start the Setup program.
6. Follow the on-screen instructions.
Mac OS X
To uninstall from a Mac computer
1. Double-click the HP Uninstaller icon (located in the Hewlett-Packard folder in the
Applications folder at the top level of the hard disk), and then click Continue.
2. When prompted, type the correct administrator's name and password, and then click OK.
3. Follow the on-screen instructions.
4, When the HP Uninstaller finishes, restart your computer.
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D Printer management tools

This section contains the following topics:
. Toolbox (Windows)

. HP_Utility (Mac OS X)

. Embedded web server

. Product security features

Toolbox (Windows)
The Toolbox provides maintenance information about the printer.

|§/f’ NOTE: The Toolbox can be installed from the HP Software CD if the computer meets the
system requirements.

Open the Toolbox

1. From the computer desktop, click the Start tab, select Programs or All Programs, click
HP, click the folder for your printer, and then select the icon with your printer's name.

2. On the Print tab, under the Print section, double-click Maintain Your Printer.

HP Utility (Mac OS X)

HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and
find website support information.

2,

[(f NOTE: The features available in HP Utility vary depending on the selected printer.

Ink level warnings and indicators provide estimates for planning purposes only. When you
receive a low on ink message, consider having a replacement cartridge available to avoid
possible printing delays. You do not need to replace cartridges until prompted to do so.

Open HP Utility
To open HP Utility

Double-click the HP Utility icon. This icon is located in the Hewlett-Packard folder in the
Applications folder at the top level of the hard disk.

Embedded web server

When the printer is connected to a network, you can use the printer's home page (embedded web
server or EWS) to view status information, change settings, and manage it from your computer.

|§/f’ NOTE: For a list of system requirements for the embedded web server, see Embedded web
server specifications.

To view or change some settings, you might need a password.

You can open and use the embedded web server without being connected to the Internet.
However, some features are not available.

This section contains the following topics:

. About cookies
. To open the embedded web server
. Embedded web server features
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About cookies

The embedded web server (EWS) places very small text files (cookies) on your hard drive when
you are browsing. These files let the EWS recognize your computer the next time you visit. For
example, if you have configured the EWS language, a cookie helps remember which language
you have selected so that the next time you access the EWS, the pages are displayed in that
language. Though some cookies are cleared at the end of each session (such as the cookie that
stores the selected language), others (such as the cookie that stores customer-specific
preferences) are stored on the computer until you clear them manually.

@ NOTE: The cookies that the EWS stores on your computer are only used for saving settings
on your computer or for sharing information between the printer and the computer. These
cookies are not sent to any HP websites.

You can configure your browser to accept all cookies, or you can configure it to alert you every
time a cookie is offered, which allows you to decide which cookies to accept or refuse. You can
also use your browser to remove unwanted cookies.

@ NOTE: Depending on your printer, if you disable cookies, you also disable one or more of
the following features:

. Starting where you left the application (especially useful when using setup wizards)
. Remembering the EWS browser language setting
. Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete
cookies, see the documentation available with your web browser.

To open the embedded web server

’Lﬁ/r NOTE: The printer must be on a network and must have an IP address. The IP address and
hostname for the printer are listed on the status report. For more information, see Understand
the network configuration page.

In a supported web browser on your computer, type the IP address or hostname assigned to the
printer.

For example, if the IP address is 123.123.123.123, type the following address into the web
browser: http://123.123.123.123

Q TIP: After opening the embedded web server, you can bookmark it so that you can return to
it quickly.

TIP: If you are using the Safari web browser in Mac OS X, you can also use the Bonjour
bookmark to open the EWS without typing the IP address. To use the Bonjour bookmark,
open Safari, and then from the Safari menu, click Preferences. On the Bookmarks tab, in
the Bookmarks bar section, select Include Bonjour, and then close the window. Click the
Bonjour bookmark, and then select your networked printer to open the EWS.

Embedded web server features

@ NOTE: Changing network settings in the HP EWS might disable some product or product
software features.

Use the Home tab to customize various views and tasks related to your device. The Home tab
includes the following items:

. Recently Visited: Displays the five most recently visited embedded HP EWS links.
. Printer Status: Displays current printer status.
. Diagnostic: Provide links to diagnostic tasks.
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. ePrint: Displays the status of ePrint connection.

. Ink Level Status: Displays ink level status.
. Manage: Useful links for managing the HP EWS.
. Wireless Network Status: Displays wireless (802.11) status.

. Wired Network Status: Displays wired (802.3) status.

. Setup: Displays setup options.

. Custom Shortcut: Customize quick links to be added as shortcut.
. Support: Links to Hewlett-Packard's support Web site.

@ NOTE: Not all of the above items are visible by default. Use the Personalize this page
button to show or hide the items of your choice.

NOTE: Settings for this page are automatically saved in the Web browser's cookies. If the
Web browser's cookies are deleted, these settings are lost.

Use the HP Web Services tab to configure and enable HP Web Services for this product. You
must enable HP Web Services to use the HP ePrint feature.

Use the Network tab to configure and secure network settings for the product when it is
connected to an IP-based network. This tab does not display if the product is connected to other
types of networks.

Tools tab
. Product Information
° Printer Information: Find basic device information such as serial number, name and
firmware version.
° Ink Gauge: See estimated ink levels, ink cartridge part numbers, and estimated
printable pages remaining for each cartridge.
° Ink Settings: Change the threshold at which the printer provides the "Low on Ink"
notification.
. Reports
° Usage Report: View the number of pages processed for printing, scanning, copying
and faxing.
° Printer Reports: Print various reports.
° Event Log: View logged events such as firmware errors.
. Utilities
° Bookmarking: Bookmark pages in the HP EWS.
° Print Quality Toolbox: Run maintenance tools to improve the print quality of your
printouts.
° Asset Tracking: Assign an asset number/location to this device.
. Backup and Restore
° Backup: Create a password-encrypted file that stores the printer's settings.

° Restore: Restore the printer's settings using a backup file created by the HP EWS.
. Job Monitor

Job Monitor: Monitor or cancel jobs currently active or pending in the printer.
. Printer Restart

° Power Cycle: Allows you to turn off and restart the printer.

° Restore: Restore the printer's settings using a backup file created by the HP EWS.

Use the Settings tab to set and maintain various options on your product including power
management, date and time, security, printing, and paper settings, email alerts, restore factory
defaults and firewall settings.
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Product security features

This product supports security standards and protocols that help secure the product, protect
information on your network, and simplify monitoring and maintenance of the product.

For information about HP's secure imaging and printing solutions, visit www.hp.com/go/
Secureprinting. The site provides links to white papers and FAQ documents about security
features and may include information about additional security features that are not contained in
this document.

Assign an administrator password in the embedded web server

The embedded web server allows you to assign an administrator password so that unauthorized
users cannot change product configuration settings in the embedded web server. When the admin
password is assigned and applied, you must enter the password to make any configuration
changes that are done through the embedded web server. If you change an existing password,
you must first enter that password. You can also remove the password by entering the existing
password and then deleting the assigned password.

Control panel lock

The embedded web server allows the ability to lock certain features on the product’s control panel
to prevent unauthorized use. Once the control panel lock is enabled, certain control panel
configuration features cannot be changed from the control panel. The control panel lock setting
itself can also be secured. This is accomplished by setting the embedded web server
administrator password. Once the embedded web server administrator password is set, the admin
password must be entered when accessing the control panel lock enable/disable setting.

Disable unused protocols and services

The embedded web server allows the ability to disable unused protocols and services. These
protocol and services settings can also be protected from being changed by setting the EWS
admin password. These protocols and services include the following:

. IPv4 and IPv6 disable/enable: To operate properly on a TCP/IP network, the product must
be configured with valid TCP/IP network configuration settings, such as an IP address that
is valid for your network. This product supports two versions of this protocol: version 4
(IPv4) and version 6 (IPv6). IPv4 and IPv6 can be enabled/disable individually or
simultaneously enabled.

. Bonjour disable/enable: Bonjour services are typically used on small networks for IP
address and name resolution where conventional a DNS server is not used. The Bonjour
service can be enabled or disabled.

. SNMP disable/enable: SNMP (Simple Network Management Protocol) is used by network
management applications for product management. This product supports the SNMPv1
protocol on IP networks. This product allows the ability to enable/disable SNMPv1.

. WINS disable/enable: If you have a Dynamic Host Configuration Protocol (DHCP) service
on your network, the product automatically obtains its IP address from that server and
registers its name with any RFC 1001 and 1002-compliant dynamic name services as long
as the Windows Internet Name Service (WINS) server IP address has been specified. The
WINS server IP address configuration can be enable or disabled. If enabled, then the
primary and secondary WINS server can be specified.

. SLP disable/enable: Service Location Protocol (SLP) is an Internet standard network
protocol that provides a framework to allow network applications to discover the existence,
location and configuration of networked services in enterprise networks. This protocol can
be enabled or disabled.

. LPD disable/enable: Line Printer Daemon (LPD) refers to the protocol and programs
associated with line-printer spooling services that may be installed on various TCP/IP
systems. LPD can be enabled or disabled.
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. LLMNR disable/enable: Link-Local Multicast Name Resolution (LLMNR) is a protocol
based on the Domain Name System (DNS) packet format that allows both IPv4 and IPv6
hosts to perform name resolution for hosts on the same local link. LLMNR can be enabled
or disabled.

. Port 9100 disable/enable: The product supports raw IP printing through TCP Port 9100.
This HP-propriety TCP/IP port on the product is the default port for printing and it is
accessed by HP software. Port 9100 can be enabled or disabled.

. Web Services disable/enable: The product supports the ability to enable or disable
Microsoft Web Services Dynamic Discovery (WS Discovery) protocols or Microsoft Web
Services for Devices (WSD) Print services supported on the product. These web services
can be enabled or disabled together or WS Discovery can be enabled separately.

. Internet Printing Protocol (IPP) disable/enable: Internet Printing Protocol (IPP) is an
Internet-standard protocol that allows you to print documents and manage jobs over the
internet. IPP can be disabled or enabled.

Administrator settings

The embedded web server allows the ability to enable and disable certain product capabilities.
These include network, Ethernet, wireless, wireless access point (i.e. disables wireless direct
capability), USB, control panel lock, color print from memory devices, all web services, only ePrint,
and only Apps. The product must be turned off, and then turned on again, for settings to take
effect.

Color access control
HP’s suite of color access control tools allows you to enable or disable color by individuals users
or groups and applications. For more information see www.hp.com/go/upd. The embedded web
server also allows you to disable color faxing, color copying, and color print from memory devices.

Protected protocols - HTTPS

The embedded web server features the ability to enable encryption of product communication
through the HTTPS redirection feature. When used, HTTPS prevents others from viewing
information between the EWS and the product via encryption — providing a secure communication
method.

Firewall

The embedded web server allows the ability to enable and configure product firewall rules,
priorities, templates, services and policies. The firewall feature provides a network-layer of
security on both IPv4 and IPv6 networks. The firewall configuration capability provides control
over IP addresses that are allowed access the product, and the ability to set permissions and
priorities for digital send, management, discovery, and print services--providing a more secure
way of controlling access to the product.

Syslog
Support of Syslog, a standard protocol for logging status messages to a designated server, can
be used to track the activities and status of devices on the network. The embedded web service
provides the ability to enable Syslog and to specify the server to which the status messages will
be sent. Specifying the priority of those status messages is also supported.

Certificates

The embedded web server provides the ability to install and manage certificates for the
authentication of product, server and network. This includes the ability to create a certificate,
install a certificate, and import and export certificates.
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Signed firmware

Support of digitally-signed firmware updates eliminates exposure to malicious software by
preventing the installation of non-approved firmware on the product.

Wireless authentication

The embedded web server provides the ability to configure wireless networking via such 802.1x
wireless enterprise authentication protocols as EAP-TLS, LEAP, and PEAP to support access
control. The HP Embedded Web Server also provides the ability to configure wireless dynamic

key encryption such as WEP encryption and WPA-PSK authentication. In addition, Wireless Direct
Authentication can be enabled or disabled.
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F Errors (Windows)

Printer disconnected
The computer cannot communicate with the printer because one of the following events has

occurred:
. The printer has been turned off.
. The cable connecting the printer, such as a USB cable or a network (Ethernet) cable, has

been disconnected.
. If the printer is connected to a wireless network, the wireless connection has been broken.
To solve this problem, try the following solutions:

Make sure the printer is turned on and that the LI_J (Power button) light is on.

. Make sure the power cord and other cables are working and are firmly connected to the
printer.

. Make sure the power cord is connected firmly to a functioning, alternating current (AC)
power outlet.

. If the printer is connected to a network, make sure the network is functioning properly. For
more information, see Solve Ethernet network problems.

. If the printer is connected to a wireless network, make sure the wireless network is

functioning properly. For more information, see Solve wireless problems.

Printhead problem
The printhead is missing, not detected, incorrectly installed, or incompatible.
If this error occurs at printer setup, try the following solutions.
Solution 1: Reinstall the printhead.
For instructions, see Reinstall the printhead

/\ CAUTION: The printheads contain electrical contacts that can be damaged easily.

If the problem persists after you reinstall the printhead, contact HP support. For more information,
see HP support.

If this error occurs after the printer has been used for a period of time, try the following
solutions.

Solution 1: Turn the printer off and on.

Turn off the printer, and then turn it on again.

If the problem persists, contact HP support for service or replacement. For more information, see
HP support.

Cartridge Problem

The ink cartridge identified in the message is missing, damaged, incompatible, or inserted into the
wrong slot in the printer.

@ NOTE: If the cartridge is identified in the message as incompatible, see Order printing
supplies online for information about obtaining cartridges for the printer.
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To solve this problem, try the following solutions. Solutions are listed in order, with the most likely
solution first. If the first solution does not solve the problem, continue trying the remaining
solutions until the issue is resolved.

. Solution 1: Turn the printer off and on.
. Solution 2: Install the ink cartridges correctly.
. Solution 3: Clean the electrical contacts.

. Solution 4: Replace the ink cartridge.

Solution 1: Turn the printer off and on

Turn off the printer, and then turn it on again.

If the problem persists, try the next solution.

Solution 2: Install the ink cartridges correctly

Make sure all of the ink cartridges are properly installed:

1. Gently pull open the ink cartridge access door.
2. Remove the ink cartridge by grasping it and pulling it firmly toward you.
3. Insert the cartridge into the slot. Press firmly on the cartridge to ensure proper contact.

4. Close the ink cartridge cover and check if the error message has gone away.
If the problem persists, try the next solution.
Solution 3: Clean the electrical contacts

To clean the electrical contacts in the printer
1. Lightly dampen a clean, lint-free cloth with bottled or distilled water.

2. Clean the electrical contacts in the printer by wiping with the cloth from top to bottom. Use
as many fresh, clean cloths as necessary. Clean until no ink shows on the cloth.

3. Wipe the area dry with a dry lint-free cloth before proceeding to the next step.
Solution 4: Replace the ink cartridge
Replace the indicated ink cartridge. For more information, see Replace the ink cartridges.

r_lﬁ NOTE: If your cartridge is still under warranty, contact HP support for service or
replacement. For more information about ink cartridge warranty, see Ink cartridge warranty
information. If the problem persists after you replace the cartridge, contact HP support. For
more information, see HP support.

Replace the ink cartridge

Replace the indicated ink cartridge. For more information, see Replace the ink cartridges.

r_lﬁ NOTE: If your cartridge is still under warranty, contact HP support for service or
replacement. For more information about ink cartridge warranty, see Ink cartridge warranty
information. If the problem persists after you replace the cartridge, contact HP support. For
more information, see HP_support.

Paper Mismatch
The paper size or type selected in the printer driver does not match the paper loaded in the
printer. Make sure that the correct paper is loaded in the printer, and then print the document
again. For more information, see Load paper.

|§/f’ NOTE: If the paper loaded in the printer is the correct size, change the selected paper size
in the printer driver, and then print the document again.
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The cartridge cradle cannot move
Something is blocking the ink cartridge cradle (the part of the printer that holds the ink cartridges).
To clear the obstruction, press l_I_J (Power button) to turn off the printer, and then check the printer
for jams.
For more information, see Clear jams.

Paper Jam
Paper has become jammed in the printer.
Before you try to clear the jam, check the following:

. Make sure that you have loaded paper that meets specifications and is not wrinkled, folded,
or damaged. For more information, see Paper specifications.

. Make sure that the printer is clean. For more information, see Maintain the printer.

. Make sure that the trays are loaded correctly and are not too full. For more information, see
Load paper.

For instructions on clearing jams, as well as more information about how to avoid jams, see Clear

jams.

The printer is out of paper
The default tray is empty.
Load more paper, and then touch OK.
For more information, see Load paper.

Printer failure

There was a problem with the printer. Usually, you can resolve such problems by completing the
following steps:

1. Press LI_J (Power button) to turn off the printer.
2. Unplug the power cord, and then plug in the power cord again.
3.

Press Ll_J (Power button) to turn on the printer.

If this problem persists, write down the error code provided in the message, and then contact HP
support. For more information about contacting HP support, see HP _support.

Door or cover open
Before the printer can print documents, all doors and covers must be closed.

Q TIP: When completely closed, most doors and covers snap into place.

If the problem persists after you've securely closed all doors and covers, contact HP support. For
more information, see HP _support.

Ink cartridges depleted

The cartridges listed in the message must be replaced to resume printing. HP recommends that
you do not remove an ink cartridge until a replacement is ready to install.

For more information, see Replace the ink cartridges.
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Ink cartridge failure
The cartridges listed in the message are damaged or have failed.
See Replace the ink cartridges.

Printer supply upgrade problem
The supply upgrade was not successful. The cartridges listed in the message can still be used in
this printer. Replace the Supply Upgrade cartridge. For more information, see Replace the ink
cartridges.

Counterfeit Cartridge Advisory

The installed cartridge is not a new, original HP cartridge. Contact the store where this cartridge
was purchased. To report suspected fraud, visit HP at www.hp.com/go/anticounterfeit. To
continue using the cartridge, click Continue.

Use SETUP cartridges

When you first setup the printer, you must install the cartridges that shipped in the box with the
printer. These cartridges are labeled SETUP, and they calibrate your printer before the first print
job. Failure to install the SETUP cartridges during the initial product setup causes an error. If you
installed a set of regular cartridges, remove them and install the SETUP cartridges to complete
printer setup. After printer setup is complete, the printer can use regular cartridges.

if you still receive error messages and the printer cannot complete ink system initialization, contact
HP support. For more information, see HP support.

Click here to go online for more information .

Do not use SETUP cartridges

New SETUP cartridges cannot be installed after the printer has been initialized. Install regular
replacement cartridges. For more information, see Replace the ink cartridges.

Not enough ink at startup

The used cartridges listed in the message might not have enough ink to complete one-time
startup processes.

Solution: Install new cartridges or click OK to use installed cartridges.

If startup cannot complete with installed cartridges, new cartridges will be needed. For information
on how to install new cartridges, see Replace the ink cartridges.

Incompatible ink cartridges
The ink cartridge is not compatible with your printer'.

Solution: Remove this cartridge immediately and replace with a compatible ink cartridge. For
information about how to install new cartridges, see Replace the ink cartridges.

Ink sensor warning

The ink sensor is reporting an unexpected condition. This could be caused by the cartridge, or the
sensor may have failed. If the sensor has failed, it can no longer sense when your cartridges are
very low on ink. Printing with an empty cartridge will cause air to enter the ink system, which
causes poor print quality. Significant amounts of ink will be used up to recover from this condition,
which will deplete much of the ink supply for all cartridges.
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Solution: Click OK to continue printing or replace the cartridge. For information about how to
install new cartridges, see Replace the ink cartridges.

Problem with printer preparation

The printer clock has failed and ink preparation may not be complete. The estimated Ink Level
gauge might be inaccurate.

Solution: Check the print quality of your print job. If it is not satisfactory, running the printhead
cleaning procedure from the toolbox might improve it.

Ink sensor failure
The ink sensor has failed and the printer can no longer print.
Contact HP support. For more information, see HP support.

Problem with ink system

Please remove the ink cartridges and examine them for any sign of leaks. If any cartridges have
leaks, contact HP. Do not use cartridges that are leaking.

If there are no leaks, re-install cartridges and close the printer cover. Turn the printer off then on
again. If you get this message a second time, contact HP.
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